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About th is User ’s Guide

iii

About this User’s Guide
Welcome to the ET180 Pocket PC Phone User’s Guide. This Guide is designed to help 
you get up and running quickly with your new ET180—a Windows® Powered Pocket PC 
2002, Phone Edition device. It describes all you need to know about how to use your new 
mobile companion as well as the application programs that come with it. 
This Guide will discuss the following topics: 

• ET180 system tour 
• Setup and maintenance procedures 
• Viewing and entering data 
• Using the phone features
• Managing information using the Microsoft® Pocket PC Phone Edition software 

programs
• Synchronising data between your ET180 and your computer
• Connecting your device to a computer, a network, or the Internet
• Personalising your device with your own preference settings

This Guide introduces you to the many ways your ET180 can help you organise and 
manage both business and personal information to make your everyday activities a more 
productive and satisfying experience. 
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First things first
We would like to thank you for making ET180 your choice for your mobile computing and 
communication needs. Your new sleek ET180 is a fully integrated PDA-mobile phone 
tool. It combines the power of high-performance PDA applications for organising 
personal and work-related information with the functionality of a mobile phone for 
communicating with your contacts. And that is not all, with high-speed GPRS technology, 
you can also keep yourself connected to the information highway. 

Your guides
To help you use your ET180, we have designed a set of guides: 

Package contents
Your ET180 comes packed in a cardboard box. Carefully unpack the box and remove the 
contents. If any of the following items are missing or damaged, contact your dealer 
immediately:

For information on: Refer to:

Programs on your device 1 This User’s Guide. 
Bundled in the ET180 Pocket PC Phone Companion 
CD, it provides online reference for using your 
device. 

The ET180 Help. To view Help, tap  and then 
Help. 

Programs on your device 1

Additional programs that 
can be installed on your 
device

The ET180 Pocket PC Phone Installation CD.

Connecting to and 
synchronising with your 
computer

The Quick Start setup flyer

ActiveSyncTM Help on your computer. To view Help, 
click Help and then Microsoft® ActiveSyncTM Help.

Last-minute updates and 
detailed technical 
information

The Read Me files. 
Located in the Microsoft® ActiveSyncTM folder on 
your computer and on the ET180 Pocket PC Phone 
Companion CD.

Up-to-date information 
regarding your device 

http://www.microsoft.com/mobile/pocketpc

1For a list of application programs bundled with your device, refer to page 27.

• ET180 Pocket PC Phone
• Stylus
• Callpad module
• Li-Ion polymer battery pack
• USB cradle
• Earphone

• Headset with remote control
• AC/DC adapter
• ET180 Pocket PC Phone Installation CD
• ET180 Pocket PC Phone User’s Guide
• ET180 Pocket PC Phone Quick Start
• Warranty Agreement
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Optional accessories
To create more variety and expand the capabilities of your ET180, you can purchase the 
following optional accessories. 

Preparing to use your ET180
Perform the following easy setup tasks to begin using your device: 
1  Install the Microsoft® ActiveSyncTM software in your computer.
2 Insert the SIM card. 

Do this procedure only if you want to utilize your device’s wireless data and/or 
voice capabilities. For instructions, go to page 65. 

3 Install the battery pack
4 Connect the USB cradle
5 Charge your device
6 Set up your device
7 Perform the first ActiveSyncTM operation

Installing the Microsoft® ActiveSyncTM software 
The main function of the Microsoft® ActiveSyncTM software is to synchronise the 
information on your computer with the information on your device. Synchronisation 
compares the data on your device with your computer and updates the information on 
both locations. This will then served as a backup file in case something happens to your 
device.
The following instructions tell you how to install the ActiveSyncTM software. 

Important installation notes 
• Before installing ActiveSyncTM, make sure that the cradle is not yet connected to 

your computer. Connect the cradle only after you have finished installing 
ActiveSyncTM.

• If you don’t have Microsoft® Outlook® 98 installed, please install Microsoft® 
Outlook® 2000 now. 

• It is recommended that users choosing to install Outlook 2000 from the 
ET180 Pocket PC Phone Installation CD do so before installing ActiveSyncTM.

• Do not copy the ActiveSyncTM files to your computer’s hard disk. You must use the 
ET180 Pocket PC Phone Installation CD to place the files in their proper locations 
and to decompress the files.

To install the Microsoft® ActiveSyncTM software
1  Exit any open programs, including those that run at startup, and disable any virus-

scanning software.
2 Insert the ET180 Pocket PC Phone Installation CD into the computer’s CD-ROM 

drive. 
The CD’s welcome page appears. 

3 Click the animated forward icon to go to the next screen. 
4 Click the Start Here tab on the right side of the screen. 
5 Read the instructions and installation notes indicated on the Start Here screen. 
6 Click the buttons on the left pane to install each of the individual applications.

• Outlook 2000 (recommended)
• ActiveSyncTM 3.5

After installation, the ActiveSyncTM icon  will appear on your computer’s system tray 
(on the lower right-hand corner of the screen). 

• Keypad module
• USB sync cable
• Extra battery pack

• Plug adapter 
• Leather cover
• Software licence agreement
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Refer to the ActiveSyncTM software online Help for information on how to use the 
software. If at any time, you would like to restart this setup program, simply re-insert the 
CD into the CD-ROM drive.

Installing the battery pack
Your ET180 uses a high-density removable and rechargeable 1480 mAH Lithium Ion 
polymer battery pack. Refer to the succeeding section for instructions on how to install 
the battery pack to your device. 

WARNING! There is a risk of fire and burns if the battery pack is handled improperly. DO NOT 
disassemble, crush, puncture, short external contacts, or dispose the battery pack in fire or water. DO 
NOT attempt to open or service the battery pack. Dispose of used batteries according to local 
recycling guidelines in your area. 

A backup battery cell is embedded into your device to prevent data loss in instances 
when the removable battery pack is removed or completely discharged. This backup 
battery cell will support the system for a maximum of 30 minutes only. 

NOTE: To enable the internal battery cell to provide backup power supply, charge your device, 
without the main battery pack, for at least four (4) hours for a minimum capacity of 30 minutes of 
backup power supply. To achieve it's full capacity of ____ backup power supply, charge it in the same 
way for at least 14 hours. 

For information on conserving power consumption to make your battery pack last longer, 
refer to page 109. 

To install the battery pack
1  Align the battery marker on the battery pack with the one located on the device.
2 Slide in the battery pack into the battery bay until it clicks into place. 

To uninstall the battery pack
1  If the device is on, press the power button to turn it off. 

Wait for five (5) seconds to allow the device to completely enter sleep mode. 
2 Press down the battery release switch, then
3 Slide out the battery pack from its bay.

Download from Www.Somanuals.com. All Manuals Search And Download.



First  th ings f i rst
Preparing to use your ET180

xii

IMPORTANT: Do not remove the battery pack for more than 30 minutes. The embedded backup 
battery cell can only provide power for this period of time after which you risk losing all data on the 
internal memory of your device. 

Connecting the USB cradle 
The cradle that comes with your device enables you to charge your device, as well as 
synchronise the information on your device with those in your computer using 
ActiveSyncTM technology. 
The dual-pocket design also allows simultaneous charging of the device and an optional 
spare battery pack if you have purchased one. 

To connect the cradle
1  Connect the AC adapter cord to the power socket at the back of the cradle. 
2 Plug the AC adapter into any AC current outlet.

Charging your ET180
For initial use, you need to charge your device for about 4 hours. After that, you can 
charge it for a few minutes each day to recharge the battery to full capacity. Normally, 
you can use your device for ____ straight hours of operation before you need to 
recharge the battery. 

NOTE: Make sure that the SIM card holder is close before charging the device.
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To charge your ET180
1  Plug the AC adapter into any AC current outlet.
2 Connect the AC adapter cord to the power socket at the back of the cradle. 
3 Slide the device into the front pocket of the cradle until it clicks into place. 

The connection is secure when the bottom edge of the device is aligned smoothly 
with the cradle, and the LED indicator on the device’s power button lights up 
green. 

LED status during charging: 
• Flashing green: Charging
• Solid green: Charging complete

If the battery level becomes low in the course of normal use, a status icon appears on the 
device screen indicating low or very low battery status (see "Status icons" on page 14). 
Perform an ActiveSyncTM operation to back up your data, then recharge the battery. 
If your device shuts down (i.e., battery is completely drained out) you have about 
30 minutes to recharge the battery before you lose all data on your device’s internal 
memory. During this period the embedded backup battery supplies power to your device.
The battery pack is removable. Refer to page xi for instructions on how to remove it from 
the battery bay. 

NOTE: You have the option to purchase a spare battery pack for your device. You can charge this 
spare battery pack in the back pocket of the cradle. Refer to page 9 for instructions.

To remove your ET180 from the cradle:
1  Gently tilt the device forward.
2 Pull the device up to detach it from the cradle.
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To recharge the device using the AC adapter cord:

When travelling you can still recharge your device and avoid the bulk of carrying the 
cradle by using the AC adapter cord to directly connect to a power outlet. 
1  Plug the AC adapter into any AC current outlet.
2 Connect the AC adapter cord to the universal connector of your device.

Setting up your ET180
After you have initially charged your device for about 4 hours, you can now set it up for 
use. Refer to the instructions below. 

NOTE: Make sure that the SIM card holder is close before turning on the device.

To set up your ET180
1  Turn on your device by pressing the power button on the front panel.
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2 Follow the onscreen instructions on the Welcome Screen Wizard.

Performing the first synchronisation process
After completing the setup procedures you can now perform the first ActiveSyncTM 
operation with the help of the 'New Partnership' setup wizard. 
This wizard will help you:

• Set up a partnership so you can synchronise information between your device and 
your computer

• Customise your synchronisation settings

To perform the first synchronisation process
1  Dock your device in the front pocket of the cradle. 
2 Plug the cradle’s USB connector into a USB port on your computer. 
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The 'New Partnership' setup wizard will automatically start on your computer screen.

NOTE: If the wizard does not automatically appear, launch ActiveSyncTM on your computer by 
clicking on its icon from Start > Programs. 

3 Follow the onscreen instructions. 
The first synchronisation process will automatically begin when you finish using 
the wizard. 

After your first synchronisation, take a look at Calendar, Contacts, and Tasks on your 
device. You'll notice that information you've stored in Microsoft® Outlook on your 
computer has been copied to your device, and you didn't have to type a word. 
Disconnect your device from your computer and you're ready to go!
Once you have set up ActiveSyncTM and completed the first synchronisation process, 
you can initiate synchronisation from your device anytime by tapping , then selecting 
ActiveSyncTM. 

Taking care of your ET180
This section provides information on the following:

• Safety information on using your device
• Recalibrating your device
• Creating backup files
• Resetting your device

Safety information on using your ET180
Your ET180’s smooth curves belies its tough construction making it an ideal combination 
of grace and strength to suit your mobile lifestyle. Observing the following safety 
information will help provide you with years of reliable and trouble-free service. 

• Retain and follow all product safety and operating instructions. 
• Observe all warnings on the product and in the operating instructions.
• Take care not to scratch the screen of your device. When using the device, use 

the supplied stylus or plastic-tipped pens intended for use with touch-sensitive 
screens. Never use an actual pen or pencil or other sharp object on the screen 
surface. 

• Take care not to drop your device or subject it to any strong impact. Do not place 
your device in your back pocket; if you sit on it, you may damage it.

• Do not place the device near heat sources such as radiators, heat registers, 
stoves, and other similar products (including amplifiers) that produce heat.

• Your device is not waterproof and should not be exposed to rain or moisture. 
• Do not use or store your device in any location that is extremely dusty, damp or 

wet. 
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• If the device went into sleep mode, allow ample time before turning it back on to 
allow for a smoother power mode transition. 

• Use the correct external power source. The device should be operated only from 
the type of power source indicated on the electrical ratings label. If you are not 
sure of the type of power source required, consult your authorized service support 
or local power company. 

IMPORTANT: This product is intended for use with certified Class 2, rated 5.4 V dc, minimum 1.85A 
power supply unit. 

• Never push unwarranted objects of any kind into any slots or openings in the 
device.

• Do not place the device on any unstable surface. 
• Use only approved peripheral devices and accessories with your device. Refer to 

the documentation that came with the peripheral device/accessory for proper 
installation and usage. 

• Unplug any cables from the product before cleaning it. Use a soft, damp cloth to 
clean your device. Do not use liquid cleaners or aerosol cleaners. 

General usage precautions
To reduce the risk of bodily injury, electric shock, fire, and damage to the equipment 
observe the following precautions:

• Heed service markings. Except as explained elsewhere in this User’s Guide, do 
not service the device yourself. Refer any all servicing needs to an authorized 
service technicians.

• When any of the below conditions are present, unplug all cables from the device 
and refer it for servicing to an authorized service technician:
–  The device has been exposed to rain or water. 
–   The device has suffered considerable impact from being dropped or an 

object has fallen on it.
–   There are noticeable signs of overheating.
–   The product does not operate normally when you follow the operating 

instructions.

Safety precautions for the main battery pack
Your device uses a removable and rechargable Lithium Ion polymer battery pack.

• Handle battery packs carefully. There is a risk of fire and burns if the battery pack 
is handled improperly. Do not attempt to open or service the battery pack.

• Do not disassemble, crush, puncture, short external contacts or circuits, dispose 
of in fire or water, or expose a battery pack to temperatures higher than 60°C 
(140°F).

• Danger of explosion if battery is incorrectly replaced. Replace only with specified 
batteries. 

• Dispose of used batteries according to the local regulations or reference guide 
supplied with the battery pack.

Screen recalibration
When you first startup your ET180, you will be asked to calibrate the screen by tapping 
the center of a cross with your stylus as it moves around the screen. This process 
ensures that when you tap the screen with your stylus the item tapped is activated.
If, however, while using your device, you discover tapping an item doesn’t bring up the 
appropriate response, it means your device has lost its calibration.

To recalibrate the screen
1  Launched the Align Screen window by doing either of the following: 

• Software launching

a Tap , and then Settings. 

b On the System tab, tap the Screen icon .
c On the Screen window, tap the Align Screen button.
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• Hardware launching
Press the button power and the jog dial simultaneously. 

2 Tap the center of the cross to with your stylus as it moves around the screen.

Creating backup files 
Any additional programs or new data in your device are stored in RAM. These items will 
be lost if you have to perform a hard reset or your device loses all power for any other 
reason. Because of this it is absolutely important that you regularly backup files to your 
computer via ActiveSyncTM or to a storage card using the device’s built-in SD/MMC slot.
When you are at your computer you can use ActiveSyncTM to synchronize files with your 
computer to serve as backup files. Refer to page 29 for more information on using 
ActiveSyncTM. 
In instances where you are unable to access your computer, you can back up files to an 
SD or MMC card. Refer to the following section for instructions. 

To save Word or Excel files in a storage card
1  Insert an SD or MMC card into the slot. 

Refer to page 5 for instructions. 
2 Open the file you want to back up. 
3 Tap Tools, then Options.
4 In the Options screen, tap the drop-down menu box under Save To and select 

Storage Card. 

5 After the backup process, remove the card from the slot. 
Follow the steps on page 6. 
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Resetting your ET180
You may have to perform a reset if the device freezes (i.e., device no longer responds to 
the buttons on the screen). 

Performing a soft reset
A soft reset allows your device to get a fresh start, similar to rebooting a computer. This 
will restart your device and adjust memory allocation. All records and entries are retained 
after a soft reset. Unsaved data in open programs may in some cases be lost. 

To perform a soft reset: 
1  Remove the stylus from its holder.
2 Lightly press the tip of the stylus to the reset button located on the rear panel of 

the device. 

Performing a hard reset
A hard reset will cut off power to your device. This will erase all records and entries, 
delete all programs you have added, and restore the device default factory settings. 
Never perform a hard reset unless a soft reset does not correct your problem. When you 
perform your next ActiveSyncTM operation, you can restore any data that you previously 
synchronised to your computer or you can restore data that you have backed up to a 
storage card. 
Refer to page xv for synchronisation procedures and to page xviii for details on how to 
back up data to a storage card. 
To perform a hard reset, do the following:
1  Hold down the power button on the front panel of your device.
2 While holding down the power button, gently press the tip of the stylus to the reset 

button.
The Confirmation message box appears. 

3 Press the volume rocker key  up. 
Refer to page 8 for the location of the volume rocker key.

NOTE: When you perform a hard reset, the current date and time are retained. Formats, preferences, 
and other settings are restored to their factory default settings.
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Locking your ET180
Your device is not just a financial investment but a wealthy source of personal 
information, some of which may be confidential so it is only logical to protect it from any 
unauthorized access. The Security setting gives you the option of assigning a lock 
password that will be required to access your device after a set period of inactivity. 

To assign a lock password

1  Tap , Settings. 

2 On the Personal tab, tap the Password icon . 
3 Select a password option.

• Simple 4 digit password
• Strong alphanumeric password

4 Define the period of inactivity before the lock password will be required for access. 
5 Enter a password then retype it to confirm.
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1 Getting to know 
your ET180 
This chapter will discuss the following topics: 

• Feature highlights of your ET180 
• ET180 system tour 
• Peripherals tour
• Basic concepts in using your ET180

Features summary
Performance

• Intel® PXA250 Cotulla application processor with speed of up to 400 MHz 
• Integrated Intel® XScaleTM Technology 
• System memory: 

– 64 MB SDRAM for application storage
– 32 MB Flash ROM for operating system

• Microsoft® Pocket PC 2002 Phone Edition software

Display
• 3.5" Transreflective TFT LCD (Thin Film Transistor Liquid Crystal Display) 
• 240 x 320 resolution
• 18-bit color depth support 
• Software-configurable backlight and contrast settings
• Microsoft® ClearType technology for clearer, crisper font display

Audio
• Embedded AC '97 CODEC with CD-quality stereo output 
• Built-in industry-standard 2.5-mm earphone jack 
• Built-in speaker and microphone

Phone features
• GSM broadband function 

– MC388 model: Dual band GSM 900/1800
– MC45 model: Tri-band GSM 900/1800/1900

• GPRS function for wireless Internet connection
• Contacts migration service using SIM Manager
• Features include Speed Dial, Caller ID, Conference Call, Call Log, 

speakerphone mode, note taking, and emergency number setting
• SMS mailbox/Inbox integration
• Customizable ring tones and ringer options
• Hardware and software launch function
• Operation time:

– Talktime (LCD off, GPRS on): 4 - 5.0 hours
– Standby time (device off, GPRS on): 120 - 150 hours
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Connectivity
• 19-pin universal connector 
• Built-in SD/MMC (Standard Digital/MultiMedia Card) expansion slot 
• IrDA1-standard Infrared wireless function 

Battery pack
• Removable and rechargeable 1480 mAH Lithium Ion polymer battery pack
• Embedded backup battery cell
• Operation time 

– PDA operation: 
– MP3 playback time (LCD off): 6.7 hours
– WMV playback time (LCD on, average level backlight, phone off): 5.32 

hours
– Internet browsing time: 
– Recording time: 

NOTE: Length of battery operation will depend on power consumption which in turn is based on 
system resources use. For example, constantly using the backlight or using power-demanding 
applications will shorten the length of battery operation.

• Charging time from empty to full capacity: 

Design and ergonomics
• Stylish and sleek design
• Form factor: 109 mm x 68.5 mm x 21.6 mm (length x width x depth)

NOTE: The depth factor indicated above is only for a unit with the battery pack attached; if the optional 
keypad module is also attached, depth factor is 24.9 mm. 

• Weight
– With battery, without keypad module: 158 g
– With battery, with keypad module: 170 g

• User-friendly navigation features 
– 3-way jog dial for one-hand operation
– Rocker key for volume control 
– Hold switch lets you lock all buttons from being accidentally pressed 

when device is placed in pocket or in a bag.
– Callpad and keypad modules for phone functions (detachable) 

1Infrared Data Association

Download from Www.Somanuals.com. All Manuals Search And Download.



1 Gett ing to know your ET180
ET180 tour

3

ET180 tour 
Front view
The illustration below shows the front panel with the keypad module attached. The top 
and bottom edges of the device are also shown. 

No. Component Description

1 Earphone jack 
cap

A non-detachable protective covering for the 
earphone jack. 

2 Earphone jack Connects to audio line-out devices (earphones/
headphones). 

3 Infrared (IR) port Uses infrared technology to transmit and receive 
data from other IR-enabled devices. 

4 SD/MMC 
expansion slot 

Accepts an SD or MMC card, allowing you to add 
more memory. 

Install add-on applications or use audio or text files 
stored in it for use with internal applications. You can 
also use it to back up data from your device. 

5 Antenna/stylus 
holder

The antenna has a neatly hidden slot for holding the 
stylus. 

To use the stylus, remove it from its holder and hold 
it the same way you hold a pen or pencil.
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6 Notification 
indicator 

Lights up solid amber for alarm reminders and email 
receipt.

7 Phone indicator Lights up green to indicate phone status. 
• Blinking slowly (600 ms on/off) - no SIM card 

inserted, PIN prompt, ongoing network 
search/user authentication/network log in

• Blinking slowly (75 ms on/3 sec. off) - 
logged to network

• Blinking slowly (75 ms on/75 ms off/3 sec. off) 
- one or more GPRS contexts activated

• Flashing - ongoing GPRS data transfer

8 Power button/
Backlight control

As a power button, press to turn on the device (LED 
lights up green) if it is off and returns to the last 
screen that was displayed, and off if it is on. 

LED status description. 
• Flashing green - Charging device
• Solid green - Charging complete

As a backlight control, press and hold to turn the 
toggle the backlight on/off. 

9 LCD 
touchscreen

Displays the applications and data stored in your 
device. It is touch-sensitive and responds to the 
stylus or your finger.

10 Keypad module Key in numbers to make a call or letters to compose 
SMS messages. 

NOTE: The keypad module is not included in the ET180 
package contents; you need to purchase this item 
separately.

11 End button • When there’s an incoming call, press 
to reject the call. 

• During an ongoing call, press to end 
the call.

• When manually dialing a number, 
press to delete the number input. 

• Press and hold to toggle on/off the 
mobile service connection.

12 Microphone Inputs audio into your device when receiving/making 
a call or recording voice notes. 

13 Universal 
connector 

Connects your device to the cradle, which in turn 
connects to the back of your computer and through 
the AC adapter to an AC main. This allows you to 
recharge your device and perform an ActiveSyncTM 
operation. 

You can also use it to connect peripheral hardware 
devices, such as an external keyboard, to your 
device. 1

No. Component Description
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Using the backlight
If lighting conditions make it difficult for you to see the information on your device, use 
the backlight to illuminate your screen. 
You can change the backlight settings. Refer to "Brightness" on page 100. 

To activate the backlight:
• Press the power button and hold it down for about two seconds. Release 

the button when the backlight turns on. 

To turn off the backlight:
• Press the power button and hold it down for two seconds. Release the 

button when the backlight turns off.

Using the SD/MMC slot
Your device has an expansion slot compatible with a range of SD and MMC storage 
cards, which are primarily used to back up or transfer files and data.

To insert a storage card:
• Hold your device securely, then push the card into the slot until you hear an 

audible system sound; this will signal that the card is already properly 
seated within the slot. 
The card is secure when it is not protruding from the base.

•

14 Send button • When there’s an incoming call, press 
to accept the call. 

• During an ongoing call, press and hold to 
toggle on/off the speakerphone mode. 

• From Speed Dial, press to call the 
currently selected number.

• From Call Log, press to call the 
currently selected log item. 

• In mailbox, press to send a composed 
email/SMS message or display options 
for a received email/SMS.

• From a PDA application, press to 
display the Dialer screen or press 
twice to redial the last called number. 

15 Speaker Listen to audio media or a phone call from here.
1 You need to install an appropriate driver to your device before using a peripheral device.

No. Component Description
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To remove a storage card:
1  Hold your device securely\, then push against the top of the card, as if you were 

pushing it further into the slot, letting the card spring out. An audible system sound 
will signal that the card has been released.

2 Gently remove the card from the slot.

Rear view

No. Component Description

1 Main battery 
release latch 

Press to release the main battery from its bay. 

2 Reset button Press the end of the stylus into the hole to reset your 
device. 

3 Main battery Removable and rechargeable 1480 mAH Lithium Ion 
polymer battery pack. 
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Left view:

No. Component Description

1 Jog dial In pop-up menus: 
- Scroll up or down to go through menu options.
- Press to select a highlighted option.

In the Dialer screen: 
- Rotate up to access Call Log.
- Rotate down to access Speed Dial.

From Speed Dial: 
- Rotate up/down to scroll through the list.
- Press to call the currently selected number.

From Call Log: 
- Rotate up/down to scroll through the log items. 
- Press to call the currently selected log item.
- Press and hold to display the pop-up menu for the 
currently selected log item.

From SIM Manager: 
- Rotate up/down to scroll through the numbers 
stored in your SIM card.
- Press and hold to display the pop-up menu for the 
currently selected entry.
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Peripherals tour 
USB cradle 
The USB cradle that comes with your device enables you to charge your device, as well 
as synchronise the information on your device with those in your computer using 
ActiveSyncTM technology. The dual-pocket design also allows simultaneous charging of 
the device and an optional spare battery pack. 

NOTE: When your device is docked in the USB cradle while the GPRS function is on, you will not be 
able to browse web pages. 

2 Volume rocker 
key

Press up to increase volume, press down to 
decrease volume. 

3 Hold switch Slide to lock all buttons from being accidentally 
pressed when device is placed in pocket or in a bag.

When hold switch is enabled: 
• Backlight is turned off and all hardware 

buttons are disabled
• Remote control functions are enabled
• Auto power off function is still active
• Sound notification for alarms, reminders and 

SD/MMC card movement are enabled

When there’s an incoming call when the hold switch 
is enabled: 

• Backlight is turned on with the caller ID 
displayed 

• All hardware keys except for the Send and 
End keys are disabled

• Backlight turns off after ending call

NOTE: Enabling the hold switch do not lock the reset 
button; you can still reset your device even if the hold 
switch is turned on. 

No. Component Description
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To charge an optional spare battery pack
1  Plug the AC adapter into any AC current outlet.
2 Connect the AC adapter cord to the power socket at the back of the cradle.
3 Slide the spare battery pack into the rear pocket of the cradle until it clicks into 

place. 

The spare battery charging indicator on the cradle will light green to indicate that 
the battery pack is properly inserted into the cradle pocket. 

Headset with remote control
The ergonomically designed headset unit that comes with your device provides quality 
sound output with maximum comfort fit. Coupled with the clip-on remote control unit, you 
can proceed to use your device’s phone and multimedia features with utmost ease of 
operation.

No. Component Description 

1 USB connector Connects the cradle to a USB port in your computer.

2 Power 
connector

Connects the cradle to a power outlet.

3 Support bracket Holds the device in place during charging.

4 Front pocket Slide in the device here for recharging. 

5 Spare battery 
charging 
indicator 

Lights up to indicate charging status for the spare 
battery pack. 

LED status description. 
• Flashing green - Charging device
• Solid green - Charging complete

6 Rear pocket Slide in a spare battery pack for or recharging. 
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\

To connect the remote control unit with the headset to the device 
1  Flip the earphone jack cap open.
2 Plug in the remote control plug to the earphone jack on the top edge of the device 

(1), then connect the headset plug to its connector on the remote control unit (2).

No. Icon Component

1 6-pole, 2.5 mm headset plug 1

2 Multimedia remote control unit

a Hold switch 2

b Forward button

c Previous button

d Clip

e Stop button

f Play/Pause button

g Remote volume rocker key 

3 6-pole, 2.5 mm remote control plug

4 Remote Send/End button

5 Headset microphone 3

6 Earphones
1 The headset can be directly attached to the earphone jack on your device.
2 When the hold switch is on, all other headset-remote control buttons are locked. 
3 When using the headset microphone during an ongoing call, the built-in device microphone is

disabled. 
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To connect the headset directly to the device 
1  Flip the earphone jack cap open.
2 Plug the headset plug directly to the earphone jack on the top edge of the device. 

Remote control operation
The table below describes the behavior of the buttons on the remote control unit when 
the unit’s hold switch is turned off. When the unit’s hold switch is turned on, all remote 
control buttons are disabled. The remote control unit won’t work when the ET180 device 
is turned off.  

NOTE: If you reset your device, you need to first open the Microsoft® Windows Media PlayerTM 

before you can again use the remote control unit. 

Action

Remote Control Buttons

Play/
Pause Stop Previous Next

Volume 
up

Volume 
down

Quick 
Press

Playback 
or pause

Stop Go to 
next 
track

Volume 
up one 
scale

Volume 
down one 
scale

Press and 
hold for > 
2 sec.

Playback 
or pause

Stop Restart 
the 
current 
track

Go to 
next 
track

Volume 
up one 
scale

Volume 
down one 
scale
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Headset operation
The table below describes the action of the Send/End button on the headset when 
there’s an active mobile phone connection. When there’s no active mobile phone 
connection or when the Phone application is turned off, the headset’s Send/End button is 
disabled. 

Keypad module
The detachable keypad module let’s you enjoy the one-hand operation of using 
conventional mobile phones for dialing and composing SMS messages.
The module has the following dimensions—63 mm x 60.3 x 3.5 mm (length x width x 
depth), with a 240 x 144 resolution rate. For your convenience, the keypad is illuminated 
in dim lighting conditions.

NOTE: The keypad module is not included in the ET180 package contents; you need to purchase 
this item separately. 

To attach the keypad module to the device
1  Remove the callpad module from the device by sliding it in a downward motion.

2 Insert then press down the keypad module into its bay until it clicks into place.
The module connector (i.e., gold bars) underneath the module should be aligned 
to its corresponding connector on the device bay.

Scenario
Action

Quick Press Press and hold for > 2 sec.

Incoming call Accept the call Accept the call

Ongoing call Terminate the call Record the ongoing call

Download from Www.Somanuals.com. All Manuals Search And Download.



1 Gett ing to know your ET180
Command interface

13

When the keypad module is attached to the device and is: 
• Flipped close - Phone is launched
• Flipped open - the last active screen before Phone was launched is displayed 

To lock/unlock the keypad module
• To lock the keypad module, press the key combination “*” + “1”
• To unlock the keypad module, press the key combination “*” + “1”; the prompt 

message “Unlock?” appears on the touchscreen. Press the Send button . 

Command interface
Hardware buttons and the stylus
Your device has hardware buttons that control actions and scroll functions, and a stylus 
for selecting items and entering information.
On your device, the stylus replaces the mouse.

• Tap. Touch the screen once with the stylus to open items and select 
options.

• Drag. Hold the stylus on the screen and drag across the screen to select 
text and images. Drag in a list to select multiple items.

• Tap and hold. Tap and hold the stylus on an item to see a list of actions 
available for that item. On the pop-up menu that appears, tap the action 
you want to perform.

Today screen
When you turn on your device for the first time each day (or after 4 hours of inactivity), 
you'll see the Today screen. You can also display it by tapping  and then Today. On 
the Today screen, you can see, at a glance, a list of important reminders for the day.

Tap to switch to 
a program. 

Tap to adjust volume or 
mute all sounds. 
Tap to change 
date and time.

Your day at a glance.

Tap to create a 
new item.

Tap to view connection 
status.

Tap to turn off the 
phone function.
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Status icons
The table below describes some of the status icons you may see on your device.

NOTE: For status icons related to the phone function, refer to page 67. 

Navigation bar and command bar
The navigation bar is located at the top of the screen. It displays the active program and 
current time, and allows you to switch to other programs and close screens.

Icon Description 

Turns all sounds on and off 

Backup battery is low 

Main battery is charging 

Main battery is low 

Main battery is very low 

Main battery is full

Connection is active 

Synchronisation is beginning or ending

Synchronisation is occurring

Notification 1 that one or more instant messages were received 

Notification that one or more email/SMS messages were received 

1 If more notification icons need to be displayed than there is room to display them, the Notification
icon appears. Tap the icon to view all notification icons.

Tap to quickly select a program 
you have recently used.

Tap to select a program.

Tap to see more programs.
Tap to customise your device.
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Use the command bar at the bottom of the screen to perform tasks in programs. The 
command bar includes menu names, buttons, and the Input Panel button. 

• To create a new item in the current program, tap New. 
• To see the name of a button, tap and hold the stylus on the button. Drag 

the stylus off the button so that the command is not carried out.

Pop-up menus
With pop-up menus, you can quickly choose an action for an item. For example, you can 
use the pop-up menu in the contact list to quickly delete a contact, make a copy of a 
contact, or send an email message to a contact. The actions in the pop-up menus vary 
from program to program. 

To access a pop-up menu
1  Tap and hold the stylus on the item that you want to perform the action on. 
2 When the menu appears, lift the stylus, then do any of the following: 

• Tap the action you want to perform. 
• Tap anywhere outside the menu to close the menu without performing 

an action.

Notifications
Your device reminds you in a variety of ways when you have something to do or receive 
an email/SMS message. For example, if you've set up an appointment in Calendar, a 
task with a due date in Tasks, or an alarm in Clock, you'll be notified in any of the 
following ways:

• A message box appears on the screen.
• A sound, which you can specify, is played.
• The notification indicator on the front panel of your device lights up amber. 

To choose reminder types and sounds for your device, tap  and then Settings. 
In the Personal tab, tap the Sounds & Notifications icon . The options you 
choose here are applied globally in your device. 

New button.

Menu
names.

Buttons.

Input panel button.

Tap and hold to display
the pop-up menu.

Lift the stylus and tap
the action you want.

Tap outside the menu
to close it without performing
an action.
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2 Entering data in 
your ET180
You can enter data into your device in several ways:

• Use the input panel to enter typed text, either by using the soft keyboard or 
other input method.

• Write directly on the screen.
• Draw pictures on the screen.
• Speak into your device’s microphone to record a message. 
• In Inbox or MSN® Messenger, use the My Text function
• Use Microsoft® ActiveSyncTM to synchronise or copy information from your 

computer to your device. 
Refer to page 29 for detailed information on using ActiveSyncTM.

Using the input panel 
Use the input panel to enter information in any program on your device. You can either 
type using the soft keyboard or write using Letter Recognizer, Block Recognizer, or 
Transcriber. In either case, the characters appear as typed text on the screen. 

NOTE: Transcriber is available only for the English and European ET180 models.

To show or hide the input panel
1  Tap the Input Panel button. 
2 Tap the arrow next to the Input Panel button to see your choices.

When you use the input panel, your device anticipates the word you are typing or writing 
and displays it above the input panel. When you tap the displayed word, it is inserted into 
your text at the insertion point. The more you use your device, the more words it learns to 
anticipate.

Input Panel button.

Select an input method.

Tap to see your choices.
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To change word suggestion options
To set word suggestion options such as the number of words suggested at one time, 
follow the steps below: 

1  Tap , Settings, then the Personal tab. 

2 On the Personal tab, tap the Input icon , then the Word Completion tab.

To type with the soft keyboard
1  Tap the arrow next to the Input Panel button, then Keyboard.
2 On the soft keyboard that is displayed, tap the keys with your stylus.

To use Letter Recognizer
With Letter Recognizer you can write letters using the stylus just as you would on paper.
1  Tap the arrow next to the Input Panel button, then Letter Recognizer.

Tap here if this
is the right word.
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2 Write a letter in the box.

When you write a letter, it is converted to typed text that appears on the screen. 

NOTE: For specific instructions on using Letter Recognizer, with Letter Recognizer open, tap the 
question mark next to the writing area.

To use Block Recognizer
With Block Recognizer you can input character strokes using the stylus that are similar to 
those used on other devices.
1  Tap the arrow next to the Input Panel button, then Block Recognizer.
2 Write a letter in the box.

When you write a letter, it is converted to typed text that appears on the screen. 

NOTE: For specific instructions on using Block Recognizer, with Block Recognizer open, tap the 
question mark next to the writing area.

To use Transcriber
With Transcriber you can write anywhere on the screen using the stylus just as you 
would on paper.

NOTE: Transcriber is available only for the English and European ET180 models.

Write a letter here.

Write a letter here.
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Unlike Letter Recognizer and Block Recognizer, you can write a sentence or more of 
information. Then, pause and let Transcriber change the written characters to typed 
characters.
1  Tap the arrow next to the Input Panel button and then Transcriber.
2 Write anywhere on the screen.

To see how to write a letter in Transcriber
1  Tap “a” on the toolbar.
2 In the screen that appears, select the letter you want to learn about, and then tap 

on one of the examples given. 

NOTE: For specific instructions on using Transcriber, with Transcriber open, tap the question mark 
in the lower right hand corner of the screen.

To punctuate in Transcriber
1  Tap the keyboard on the toolbar.
2 Tap the punctuation mark you need.

Click a letter for a demonstration.
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3 Tap OK to hide the toolbar.

Selecting and editing typed text
If you want to edit or format typed text, you must select it first.
1  Drag the stylus across the text to select it. 
2 To cut, copy, and paste typed text:

a Tap and hold the selected words
b Tap an editing command on the pop-up menu, or tap a command on the Edit 

menu.

Writing on the screen
In any program that accepts writing, such as the Notes program, and in the Notes tab of 
Calendar, Contacts, and Tasks, you can use your stylus to write directly on the screen. 
Write the way you do on paper. You can edit and format what you've written and convert 
the information to text at a later time.
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To write on the screen
• Tap the Pen button to switch to writing mode. This action displays lines on 

the screen to help you write.

NOTE: Some programs that accept writing may not have the Pen button. See the documentation for 
that program to find out how to switch to writing mode.

To select and edit written text
If you want to edit or format written text, you must select it first.
1  Tap and hold the stylus next to the text you want to select until the insertion point 

appears.
2 Without lifting, drag the stylus across the text you want to select.

If you accidentally write on the screen, tap Tools, then Undo and try again. 
-or-
Tap the Pen button to deselect it and then drag the stylus across the screen.

3 You cut, copy, and paste written text in the same way you work with typed text: 
a Tap and hold the selected words
b Tap an editing command on the pop-up menu, or tap a command on the Edit 
menu.

Tap the Pen button and use
your stylus like a pen.
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To convert writing to text
• Tap Tools and then Recognize.

If you want to convert only certain words, select them before tapping 
Recognize on the Tools menu (or tap and hold the selected words and then 
tap Recognize on the pop-up menu). If a word is not recognized, it is left as 
writing.

If the conversion is incorrect, you can select different words from a list of alternates or 
return to the original writing. To do so: 
1  Tap and hold the incorrect word (tap one word at a time). 
2 On the pop-up menu, tap Alternates. 

A menu with a list of alternate words appears. 
3 Do either of the following: 

a Tap the word you want to use. 
b Tap the writing at the top of the menu to return to the original writing.

NOTE:
Hyphenated words, foreign words that use special characters such as accents, and some punctuation 
cannot be converted.

If you add writing to a word to change it (such as changing a "3" to an "8") after you attempt to 
recognise the word, the writing you add will not be included if you attempt to recognise the writing 
again. 

Select the text you want
to convert and tap Recognize on the
pop-up menu.

The writing is turned into
text.

Or, tap the word you want
to use.

Tap to return to your
original writing.
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Tips for getting good recognition
• Write neatly.
• Write on the lines. Write the cross of the "t" and apostrophes below the top 

line so that they are not confused with the word above. Write periods and 
commas above the line.

• For better recognition, try increasing the zoom level to 300% using the 
Tools menu.

• Write the letters of a word closely and leave big gaps between words so 
that your device can easily tell where words begin and end.

Drawing on the screen
You can draw on the screen in the same way that you write on the screen. The difference 
between writing and drawing on the screen is how you select items and how they can be 
edited. For example, selected drawings can be resized, while writing cannot.

To create a drawing
1  Cross three ruled lines on your first stroke. 

A drawing box appears. 
2 Subsequent strokes in or touching the drawing box become part of the drawing.

Drawings that do not cross three ruled lines will be treated as writing.

TIP: You may want to change the zoom level so that you can more easily work on or view your 
drawing. Tap Tools and then select a zoom level.

To select a drawing
If you want to edit or format a drawing, you must select it first.

• Tap and hold the stylus on the drawing until the selection handle appears. 
• To select multiple drawings, deselect the Pen button and then drag to 

select the drawings you want.

To edit a drawing
• To cut, copy, and paste selected drawings: 

a Tap and hold the selected drawing. 
b Tap an editing command on the pop-up menu, or tap a command on the Edit 

menu. 

The drawing box indicates
the boundaries of the drawing.

Pen button.
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• To resize a drawing: 
a Make sure the Pen button is not selected. 
b Drag a selection handle until desired size is attained.

NOTE: You may want to change the zoom level so that you can more easily work on or view your 
drawing. Tap Tools and then select a zoom level.

Recording a message
In any program where you can write or draw on the screen, you can also quickly capture 
thoughts, reminders, and phone numbers by recording a message. 

• In Calendar, Tasks, and Contacts, you can include a recording in the Notes 
tab of the Edit menu. 

• In Notes, you can either create a stand-alone recording or include a 
recording in a written note. 
Refer to the succeeding sections for instructions. 

• In Inbox, you can add a recording to an email message. 

To create a recording in Notes
1  Tap , then Notes.

If you want to include the recording in a note, open the note first. 

2 Tap  on the command bar. 
3 Position your device's microphone near your mouth or other source of sound.

NOTE: Refer to "Front view" on page 3 for the location of your device’s microphone.

4 On the Recording toolbar, tap . 
Start recording after the beep sound.

5 Tap  to stop recording. Two beeps will sound.
The new recording appears in the note list or as an embedded icon.

TIP: You can also use the microphone built-in the headset unit bundled with your device to create a 
recording. Attached first the headset to your device. 

To play a recording
• Tap it in the list or tap its icon in the note.
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Using My Text
When using Inbox or MSN® Messenger, use My Text to quickly insert preset or frequently 
used messages into the text entry area. 

To insert a My Text message
1  Tap My Text on the screen’s command bar. 
2 Tap a message.

NOTE: You can add text after inserting a My Text message before sending it.

To edit a My Text message
1  In the Tools menu, tap Edit and then tap My Text Messages. 
2 Select the message you wish to edit and make the desired changes.

Indicates an embedded
recording.

Tap to show or hide
the Recording toolbar.

Tap to begin recording.

Tap to select a
prewritten message.
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3 Managing applications 
and information 
This chapter will discuss the following topics: 

• Opening and switching between applications in your device
• Using File Explorer to manage files
• Using the Find function to look for a specific file
• Using ActiveSyncTM to exchange and update data

Opening an application
You can open applications by doing either of the following: 

• Tap a program name from the  menu. 

NOTE: You can customise which programs you see on the  menu. For instructions, see "Adding 
a program to the Start menu" on page 106. 

• Tap , then Programs to see more programs.

Switching between applications
Choose from the following options to switch between applications:

• Select another program from the  menu. 

NOTE: Some programs have abbreviated labels for check boxes and drop-down menus. To see the 
full spelling of an abbreviated label, tap and hold the stylus on the label. Drag the stylus off the label 
so that the command is not carried out. 

The following table contains a partial list of programs that are available on your device. 
Refer to the ET180 Pocket PC Phone Installation CD for additional programs that you 
can install in your device.  

Icon Program Usage

ActiveSyncTM Synchronise information between your device and your 
computer.

Calendar Keep track of your appointments and create meeting 
requests.

Contacts Keep track of your friends and colleagues.

Inbox Send and receive email messages.

Notes Create handwritten or typed notes, drawings, and 
recordings.
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Finding and organising information
Use the Find function and the File Explorer window to search for specific files and 
manage your files easily.

To use Find
The Find function helps you quickly locate specific files. 

1  On the  menu, tap Find. 
2 Enter the text you want to find, then select a data type.

TIP: To quickly find information that is taking up storage space on your device, select the Larger than 
64 KB option from the Type drop-down box.

Microsoft® 
Reader for 
Pocket PC 

Download and read eBooks on your device. 

MSN® 
Messenger

Send and receive instant messages with your MSN® 
Messenger contacts.

Tasks Keep track of your tasks.

Phone Make and receive calls and SMS messages; swap 
between calls and set up conference calling.

Pocket Excel Create new workbooks or view and edit Excel 
workbooks created on your computer.

Pocket 
Internet 
Explorer

Browse Web and WAP sites, and download new 
programs and files from the Internet.

Pocket Word Create new documents or view and edit Word 
documents created on your computer.

SIM 
Manager

Loads contents of your SIM card to your device and 
transfer it to Contacts.

Solitaire Play your favorite card game online for on-the-road 
entertainment.

Windows 
MediaTM 
Player

Play digital audio and video files that are on stored on 
your device or on a network. 

Terminal 
Services 
Client 

Log onto a Windows NT server type PC that is running 
Terminal Services software and use all of the programs 
that are available on that PC from your device. 

Icon Program Usage
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3 Tap  to start the search.

To use File Explorer
Use File Explorer to locate files on your device and to organise these files into folders. 

• On the  menu, tap Programs, and then File Explorer .

 Using ActiveSyncTM

Using ActiveSyncTM, you can synchronise information in Microsoft® Outlook or Microsoft® 
Exchange on your computer with your device. You can also synchronise this information 
directly with a Microsoft® Exchange server. Each time you synchronise, ActiveSyncTM 
compares the changes you made on your device and computer or server and updates 
both locations with the latest information. For example:

• Keep Pocket Outlook® data up-to-date by synchronising your device with 
the Microsoft® Outlook data on your computer. 

• Synchronise Microsoft® Word and Microsoft® Excel files between your 
device and your computer. Files are automatically converted to the correct 
format.

By default, ActiveSyncTM does not automatically synchronise all types of information. Use 
ActiveSyncTM options to turn synchronisation on and off for specific information types.

You can also use ActiveSyncTM to:
• Back up and restore data in your device. 
• Copy (rather than synchronise) files between your device and your computer. 

Tap here to 
start search.

Type text you 
want to find. 

Tap the folder name
to open it.

Tap and hold to create
a new folder.

Select the sort order
for the list.

Tap to change folders.
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• Control when synchronisation occurs by selecting a synchronisation mode.
For example, you can synchronise continually while connected to your 
computer or only when you choose the synchronise command.

• Select which information types are synchronised and control how much data is 
synchronised. 
For example, you can choose how many weeks of past appointments you 
want synchronised.

Before you begin synchronisation, install ActiveSyncTM on your computer from the 
ET180 Pocket PC Phone Installation CD. 

NOTE: ActiveSyncTM is already installed on your device.

For instructions on installing ActiveSyncTM, go to page x or you could refer to the ET180 
Pocket PC Phone Quick Start flyer included in the package contents. 
For detailed information about using ActiveSyncTM on your computer, start ActiveSyncTM 
on your computer, and then see ActiveSyncTM Help.

To open ActiveSyncTM on your device

• Tap , and then tap ActiveSync . TM

To remotely synchronise your device 

1  Tap , and then ActiveSync . 
2 In the Tools menu, tap Options. 
3 In the PC tab, select Include PC when synchronising remotely then select your 

computer's name. 
Remote synchronisation with a computer will work only if you have set up a 
partnership with that computer through ActiveSyncTM and have set ActiveSyncTM 
to allow remote connections. Other restrictions apply. 
For more information on remote synchronisation, see ActiveSyncTM Help on your 
computer.

Tap to connect and synchronize.

View synchronization status.

Tap to synchronize via IR or
change synchronization settings.

View connection status.

Tap to stop synchronization.
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4 Managing Microsoft® 
Pocket Outlook® applications
This chapter will discuss the basic applications included in the Microsoft® Pocket 
Outlook® program installed in your device. This discussion will include: 

• Calendar 
• Contacts 
• Tasks 
• Notes 
• Inbox - for more information on this program refer to page 57. 

You can use these programs individually or in tandem with each other. For example, 
email addresses stored in Contacts can be used to address email messages in Inbox. 

 Calendar
Calendar enables you to conveniently manage your schedules and appointments or any 
other activities associated with a time and date. You can schedule appointments, 
including meetings and other events. Checking your appointments is easy using one of 
several views—Agenda, Day, Week, Month, and Year. 

NOTE: Switch view options by using the View menu. 

To open Calendar

• Tap , then Calendar.
Calendar will open to today’s schedule. 

NOTE: You can customise the Calendar display, such as changing the first day of the week, by 
tapping Options on the Tools menu. 

Tap to go to today.

Tap to display or edit
the appointment details.

Tap to create a new appointment.
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Scheduling an appointment
You can use Calendar to create an appointment schedule.

To create an appointment
1  If you are in Day or Week view, tap the desired date and time for the appointment.
2 Tap New.

3 Using the input panel, enter a description and a location. 
Tap first to select the field. 

4 If needed, tap the date and time to change them.
5 Enter other desired information. 

You will need to hide the input panel to see all available fields.
6 To add notes, tap the Notes tab. 

You can enter text, draw, or create a recording. For more information on creating 
notes, go to page 37.

7 After completing the details, tap OK. 

TIP: If you select Remind me in an appointment, your device will remind you according to the options 
set in , Settings, Personal tab, Sounds & Notifications. 

To use the Calendar summary screen
When you tap an appointment in Calendar, a summary screen is displayed. To change 
the appointment, tap Edit.

Tap to select a date.

Tap to select a time.

Tap to return to the calendar
(the appointment is saved
automatically).

Tap to choose from
previously entered locations.

Tap to choose from
predefined text.

Notes is a good place
for maps and directions.
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Creating a meeting request
You can use Calendar to set up meetings with users of Outlook or Pocket Outlook®. The 
meeting request will be created automatically and sent when you synchronise Inbox or 
when you connect to your email server. Indicate how you want meeting requests sent by 
tapping Tools and then Options. If you send and receive email messages through 
ActiveSyncTM, select ActiveSync.

To schedule a meeting
1  Create an appointment.
2 In the appointment details, hide the input panel, and then tap Attendees.
3 From the list of email addresses you've entered in Contacts, select the meeting 

attendees. 
The meeting notice is created automatically and placed in the Outbox folder.
For more information on sending and receiving meeting requests, see the Help menu of 
Calendar and Inbox in your device.

 Contacts
Contacts maintains a list of your friends’ and colleagues’ contact information. Using your 
device’s infrared (IR) port, you can quickly share this list with other Windows-based, 
IR-enabled device users.

To open Contacts

• Tap , then Contacts.
Contacts will open to the contact list.

View appointment details.

View.

Tap to change
appointment.
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NOTE: To change the way information is displayed in the list, tap Tools and then Options.

Creating a contact
1  Tap New.

2 Using the input panel, enter a name and other contact information. 
You will need to scroll down to see all available fields.

3 To assign the contact to a category, scroll to and tap Categories and select a 
category from the list. 
In the contact list, you can display contacts by category.

4 To add notes, tap the Notes tab. 
You can enter text, draw, or create a recording. For more information on creating 
notes, go to page 37.

5 After completing the details, tap OK. 

Finding a contact
There are six ways to find a contact. In the contact list: 

• Rotate up and hold the jog dial until alphabetical letters appear on the 
screen in large type. Rotate the dial up or down to scroll through the 
alphabet, then press the dial to select a letter.

• Tap one of the grouping of letters displayed across the top of the screen.

Notes is a good place
for maps and directions.

Tap to return to the contact
list (the contact is saved
automatically).

Scroll to see more fields.
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• Enter a contact name in the box under the navigation bar.
To show all contacts again, clear text from the box or tap the button to the right of 
the box. 

• Tap the category list (labeled All Contacts by default) and select the type of 
contact that you want displayed. 
To show all contacts again, select All Contacts. 
To view a contact not assigned to a category, select No Categories. 

• To view the names of companies your contacts work for, in the command bar, tap 
View > By Company. 
The number of contacts that work for that company will be displayed to the right of 
the company name. 

• Tap , Find, enter the contact name, select Contacts for the type, and then tap 
Go. 

To use the Contacts summary screen
When you tap a contact in the contact list, a summary screen is displayed. To change the 
contact information, tap Edit.

 Tasks
Use Tasks to keep track of what you have to do and prioritise them based on their 
importance and urgency. 

To open Tasks

• Tap , then Tasks. 
Tasks will open to the tasks list.

View contact details.

Tap to view notes.

Tap to change contact information.
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NOTE: To change the way information is displayed in the list, tap Tools and then Options.

Creating a task
1  Tap New.
2 Using the input panel, enter a description.
3 You can enter a start date and due date or enter other information by first tapping 

the field. 
If the input panel is open, you will need to hide it to see all available fields.

4 To assign the task to a category, tap Categories and select a category from the 
list. 
In the task list, you can display tasks by category.

5 To add notes, tap the Notes tab. 
You can enter text, draw, or create a recording. For more information on creating 
notes, go to page 37.

6 After completing the details, tap OK.

Tap to create a new  task.

Select the sort order
of the list.

Indicates high priority.

Select the category of tasks
you want displayed in the list.

Tap to display or edit
the task details.

Tap and hold to display
a pop-up menu of actions.

Tap to return to the task
list (the task is saved
automatically).

Tap to choose from
predefined subjects.

Notes is a good place
for maps and drawings.
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TIP: To quickly create a task with only a subject, tap Entry Bar on the Tools menu. Then, tap Tap Here 
to add a new task and enter your task information.

To use the Tasks summary screen
When you tap a task in the task list, a summary screen is displayed. To change the task, 
tap Edit.

 Notes
Quickly capture thoughts, reminders, ideas, drawings, and phone numbers with Notes. 
You can create a written note or a recording. You can also include a recording in a note. 
If a note is open when you create the recording, it will be included in the note as an icon. 
If the note list is displayed, it will be created as a stand-alone recording.

To open Notes

• Tap  then, Notes. 
Notes will open to the note list. 

Creating a note
1  Tap New.

View task details.

View notes.

Tap to show and hide additional
summary information.

Tap to change task.

Tap to open a note or
play a recording.

Tap and hold to display
a pop-up menu of actions.

Tap to create a new  item.

Tap to change the sort
order of the list.

Tap to show or hide the
Recording toolbar.

Tap to record.
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2 Create the note by writing, drawing, typing, or recording.
For more information about using the input panel, writing and drawing on the 
screen, and creating recordings, see "2 Entering data in your ET180" on page 17.

Tap to return to the note
list (the note is saved
automatically).

Tap to write on the screen.

Tap to show or hide
the input panel.

Tap to add a recording
to the note.
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5 Managing Microsoft® Pocket 
PC 2002 companion programs
Perform your usual computing tasks on-the-road using the Microsoft® Pocket PC 2002 
companion programs which include: 

• Pocket Word
• Pocket Excel
• Microsoft® Windows Media™ Player for Pocket PC
• Microsoft® Reader for Pocket PC

NOTE: Microsoft® Reader is available only for the English and European ET180 models. 

 Pocket Word
Pocket Word works with Microsoft® Word on your computer to give you easy access to 
copies of your documents. You can:

• Create new documents on your device, such as letters, meeting minutes, and trip 
reports, or you can copy documents from your computer to your device. 

• Synchronise documents between your computer and your device so that 
you have the most up-to-date content in both locations.

For more information on using Pocket Word, tap  > Programs > Pocket Word then, 
tap Help from the  menu.

Creating a new file 
• Tap  > Programs > Pocket Word > New. 

A blank document appears. Or, if you've selected a template for new 
documents in the Options dialog box, that template appears with 
appropriate text and formatting already provided. 

You can open only one document at a time; when you open a second document, you'll be 
asked to save the first. You can save a document you create or edit in a variety of 
formats, including:

To use the Pocket Word file list
Pocket Word contains a list of the files stored on your device.

• Tap a file in the list to open it. 
• To delete, make copies of, and send files, tap and hold a file in the list. 

Then, select the appropriate action on the pop-up menu.

• Word (.doc)
• Pocket Word (.psw)

• Rich Text Format (.rtf)
• Plain Text (.txt)
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Entering information 
You can enter information in Pocket Word in one of four modes—typing, writing, drawing, 
and recording, which are displayed on the View menu. Each mode has its own toolbar, 
which you can show and hide by tapping the Show/Hide Toolbar button on the command 
bar.
If you're opening a Word document created on a computer, select Wrap to Window on 
the View menu so that you can see the entire document.

TIP: You can change the zoom magnification by tapping View and then Zoom. Then select the 
percentage you want. Select a higher percentage to enter text and a lower one to see more of your 
document.

Typing mode
• Using the input panel, enter typed text into the document. 

For more information on entering typed text, refer to "Using the input panel" on 
page 17.

• To format existing text and to edit text, first select the text. You can select text as 
you do in a Word document, using your stylus instead of the mouse to drag 
through the text you want to select. 

• You can search a document to find text by tapping Edit and then Find/Replace.

Tap to change the sort
order of the list.

Tap to open a document.

Tap and hold an item to see
a pop-up menu of actions.

Tap to create a new document.

Select the type of folder you
want displayed in the list.
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Writing mode
In writing mode, use your stylus to write directly on the screen. Ruled lines are displayed 
as a guide, and the zoom magnification is greater than in typing mode to allow you to 
write more easily.
For more information on writing and selecting writing, refer to "Writing on the screen" on 
page 21.

If you cross three ruled lines in a single stylus stroke, the writing becomes a drawing, and 
can be edited and manipulated as described in the following section.

NOTE: Written words are converted to graphics (metafiles) when a Pocket Word document is converted 
to a Word document on your computer.

Drawing mode
In drawing mode, use your stylus to draw on the screen. Gridlines appear as a guide. 
When you lift your stylus off the screen after the first stroke, you'll see a drawing box 
indicating the boundaries of the drawing. Every subsequent stroke within or touching the 
drawing box becomes part of the drawing. 
For more information on drawing and selecting drawings, see "Drawing on the screen" 
on page 24.

Tap to change
formatting options.

Tap to format text.

Tap and hold to see a
pop-up menu of actions.

Tap to show or hide
the toolbar.

Tap to return to the
document list (changes are
saved automatically).

With Space button selected,
drag to insert space. An arrow
appears showing the space
direction and size.

Tap to highlight selected text.

Space button.

Tap to select formatting options,
such as pen weight and line color.

Pen button.
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Recording mode
In recording mode, you can embed a recording into your document. Recordings are 
saved as .wav files. For more information on recording, see "Recording a message" on 
page 25.

 Pocket Excel
Pocket Excel works with Microsoft® Excel on your computer to give you easy access to 
copies of your workbooks. You can:

• Create new workbooks on your device, such as expense reports and mileage 
logs, or you can copy workbooks from your computer to your device. 

• Synchronise workbooks between your computer and your device so that you have 
the most up-to-date content in both locations.

For more information on using Pocket Excel, tap  > Programs > Pocket Excel then, 
tap Help from the  menu.

Creating a new workbook
• Tap , Programs, Pocket Excel, and then New. 

A blank workbook appears. Or, if you've selected a template for new workbooks in 
the Options dialog box, that template appears with appropriate text and formatting 
already provided. 

You can open only one workbook at a time; when you open a second workbook, you'll be 
asked to save the first. You can save a workbook you create or edit in a variety of 
formats, including:

• Pocket Excel (.pxl)
• Excel (.xls)

To use the Pocket Excel file list
Pocket Excel contains a list of the files stored on your device. 

• Tap a file in the list to open it. 
• To delete, make copies of, and send files, tap and hold a file in the list. Then 

select the appropriate action from the pop-up menu.

Displaying the toolbar
Pocket Excel provides fundamental spreadsheet tools, such as formulas, functions, 
sorting, and filtering, in its toolbar.

Select Shape on the
pop-up menu to convert
objects to proper shapes.

Resize an object by dragging
the selection handles.

Tap an arrow  to
see your choices.

Tap to select formatting options,
such as line weight, fill color, and line color.

Pen button.
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• Tap View and then Toolbar. 

Protecting your workbooks
If your workbook contains sensitive information, you can protect it with a password. 

• Open the workbook, tap Edit, and then Password. 
Every time you open the workbook, you will need to enter the password, so 
choose one that is easy for you to remember but hard for others to guess.

Tips for working in Pocket Excel
Note the following when working in large worksheets in Pocket Excel:

• View in full-screen mode to see as much of your worksheet as possible. 
– Tap View and then Full Screen. 
– To exit full-screen mode, tap Restore.

• Show and hide window elements. 
– Tap View and then tap the elements you want to show or hide.

• You might want to freeze the top and left-most panes in a worksheet to keep row 
and column labels visible as you scroll through a sheet. 
a Select the cell where you want to freeze panes. 
b Tap View and then Freeze Panes. 

• Split panes to view different areas of a large worksheet. 
a Tap View and then Split.
b Then drag the split bar to where you want it.
To remove the split, tap View and then Remove Split.

• Show and hide rows and columns. 
– To hide a hidden row or column:
a Select a cell in the row or column you want to hide.
b Tap Format, then Row or Column, and then Hide. 
– To show a hidden row or column: 
a Tap Tools, then Go To. 
b Type a reference that is in the hidden row or column.
c Tap Format, then Row or Column, and then Unhide.

 Microsoft® Windows Media™ Player 
for Pocket PC

Use Microsoft® Windows Media™ Player for Pocket PC to play digital audio and video 
files (Windows Media and MP3 files) that are on stored on your device or on a network.

Cell contents appear here
as you enter them.

AutoSum button.

Format button.

Zoom button.
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For more information about using Windows Media™ Player for Pocket PC, tap , and 
then tap Help.

 Microsoft® Reader for Pocket PC
Use Microsoft® Reader for Pocket PC to read eBooks on your device. You can also 
download books from your favorite eBook Web site to your computer. Then, use 
ActiveSyncTM to copy the book files to your device. The books appear in the Reader 
Library, where you can tap them in the list to open them. 

NOTE: Microsoft® Reader is available only for the English and European ET180 models.

Using Guidebook 
Guidebook contains all the information you'll need to use the Microsoft® Reader. 

To open Guidebook
• Tap Help on the Reader command bar. 

-or-
• On a book page, tap and hold on the book title, and then tap Help on the 

pop-up menu.

Getting books on your ET180
You can purchase and download book files from the Web to your PC and then 
synchronize them with your ET180. To do so, you need to activate your device (you only 
need to activate it once), secure an activated copy of MSReader for your PC, and then 
set up synchronization for files in ActiveSyncTM. Follow the steps below. 
1  Open ActiveSyncTM on your computer then check you have selected Synchronize 

Files - if you have done so it will appear under Information Type; if you have not, 
click Options, Sync options, then select Files and then OK from the pop-up menu.

2 To activate your device, open a web browser, go to http://das.Microsoft.com/
activate/ and follow the instructions.

3 Go to one of the Microsoft® Reader ebook sites (www.microsoft.com/reader/
shop.asp) and follow the instructions in the site for choosing, purchasing and 
downloading an ebook to your computer. 

Tap to play or pause.

Tap to stop.

Tap to play a 
previous track.

Tap to skip to 
the next track.

Tap to shift to the 
Fullscreen mode.

Tap to adjust volume.

Indicates the progress 
of the current track.
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NOTE:
If you do not have a copy of MSReader on your PC, go to one of the retailers listed above and download 
a free copy.

You can also download ebook files from your favorite eBook retailer and follow the instructions to 
download the ebook files. 

4 Use Windows Explorer on your computer to locate the MSReader “My Library” 
folder and the “Pocket_PC My Documents” folder, find the book title in the “My 
Library” folder, and then copy it to the “Pocket_PC My Documents” folder. 

5 Use ActiveSyncTM to download the files from your computer to your ET180 as 
described in the Read Me file in the MSReader folder. 

TIP: Some sample books and a dictionary are included in the MSReader folder. This folder is located in 
the Extras folder on the ET180 Pocket PC Phone Installation CD. 

Using Library
The Library is your Reader home page; it displays a list of all books stored on your 
device or storage card.

To open Library
• On the Reader command bar, tap Library. 

-or-
• On a book page, tap the book title, and then tap Library on the pop-up menu.

Opening a book
• Tap a book title in the Library list.

Reading a book
Each book consists of a cover page, an optional table of contents, and the pages of the 
book. You can:

• Annotate the book with highlighting, bookmarks, notes, and drawings.
• Search for text and look up definitions for words.

In addition to the text, each book page includes a page number and book title.
Navigation options are listed in the bottom portion of the cover page. Page through the 
book by: 

• Using the jog dial on the left side of your device
• Tapping the page number on each page

Tap to open a book.

Tap to scroll through
the Library list.

Tap to specify
the books you

want to display
in the list.

Tap to select
a sort order.

Tap here to
navigate to

other parts of
the Reader.
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The first time you open a book, the table of contents, if there is one, will be displayed. 
Subsequently, whenever you open the book, you'll be automatically taken to the last 
page read.

Using the Reader features
Reading a book electronically gives you several options not available with paper books. 
These options are available from any book page.
Select text by dragging across the text on the page. Then, tap an option on the pop-up 
menu, as described in the following sections. 

To search for text
1  Tap Find on the pop-up menu. 
2 Enter the word you want to search for. 
3 Tap the desired Find option. 

Reader highlights found matching text on the page. 
• To close Find, tap outside the box. 
• To return to your original page, tap the title and then tap Return on the pop-

up menu.

To copy text 
You can copy text from books that support this feature into any program that accepts 
text. 
1  On a book page, select the text you want to copy. 
2 Tap Copy Text on the pop-up menu. 

The text can be pasted into the program of your choice.

To view book annotations 
To see a list of a book's annotations, including bookmarks, highlights, text notes, and 
drawings: 
1  Tap Annotations Index on the book's cover page. 
2 Tap an entry in the list to go to the annotated page.

Bookmarks 
• When you add a bookmark to a book, a colour-coded bookmark icon appears in 

the right margin. From anywhere in the book, tap the bookmark icon to go to the 
bookmarked page.

NOTE: You can add multiple bookmarks to a book. 

Drag to select text and
then tap an option.

Tap arrows to turn
the page, or tap and
hold page # to bring
up page riffle.

Tap to select
a navigation

option.
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Highlights
• When you highlight text, it appears with a coloured background. 

Notes
• When you attach a note to text, you enter the text in a note pad that appears on 

top of the book page. A Note icon will appear in the left margin. To show or hide 
the note, tap the icon.

Drawings 
• When you add a drawing, a Drawing icon appears in the bottom-left corner of the 

page, and drawing tools appear across the bottom of the page. Draw by dragging 
your stylus.

Removing a book
When you finish reading a book, you can delete it to conserve space on your device. If a 
copy of the book is stored on your computer, you can download it again at any time. 
1  Tap and hold the title in the Library list.
2 Tap Delete on the pop-up menu.
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6 Getting connected
You can use your ET180 to exchange information with other mobile devices and connect 
to your computer, a network, or the Internet. You have the following connection options:

• Use the infrared (IR) port on your device to send and receive files from another 
IR-enabled device. 

• Connect to your Internet service provider (ISP). Once connected, you can send 
and receive email messages by using Inbox and view Web or WAP pages by 
using Pocket Internet Explorer. 
The communication software for creating an ISP connection is already installed 
on your device. Your service provider will provide software needed to install other 
services, such as paging and fax services. 

• Connect to the virtual private network (VPN) at the company or organisation 
where you work. Once connected, the added security of a VPN means that you 
can access the full resources of your company’s network. For example, you can 
use File Explorer to access the files of computers on that network. 

Infrared communication
Using infrared, you can send and receive information, such as contacts and 
appointments from another IR-enabled device.
Refer to "Front view" on page 3 for the location of your device’s IR port.

Sending information
1  Switch to the program where you created the item you want to send and locate 

the item in the list.

2 Align the IR port  of your device with that of the IR-enabled device so that 
they are unobstructed and within a close range.

3 Tap and hold the item, and then tap Beam Item on the pop-up menu.
-or- 
Send items (but not folders) using File Explorer. 
• Tap and hold the item you want to send and then tap Beam File on the pop-up 

menu.

Receiving information
1  Align the IR port of your device with that of the IR-enabled device so that they are 

unobstructed and within a close range. 
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2 Have the owner of the other device send the information to you. Your device will 
automatically receive it.

3 On the Receiving Data popup, tap Yes.

Connecting to the Internet
Your ET180 allows you to connect to your mobile ISP, and use the connection to send 
and receive email messages and view Web or WAP pages. 
For more information on the various wireless data communication programs bundled 
with your device, go to "7 Wireless data programs" on page 53.

Connecting to a network
If you have access to a network at work, you can send email messages, view Intranet 
pages, synchronise your device, and possibly access the Internet. You can connect to a 
network by creating a modem connection via a RAS account. 
Before you can create this modem connection, your network administrator will need to 
set up a RAS account for you. If this is the method you want to use, see "To create a 
modem connection to a network" later on this page. Your network administrator may also 
give you VPN settings.

To create a modem connection to a network
1  Get the following information from your network administrator:

• Dial-up access telephone number
• User name and password
• Domain name
• TCP/IP settings

2 If your device does not have a built-in modem, install a modem card.

3 Tap  and then Settings. In the Connections tab, tap the Connections icon . 
4 Under the Internet settings, select Internet Settings and tap Modify.
5 In the Modem tab, tap New.
6 In the Make New Connection window, enter a name for the connection. 
7 In the Select a modem list, select your modem type.

If your modem type does not appear, try re-inserting the modem card. If you are 
using an external modem that is connected to your device with a cable, select 
Hayes Compatible on COM1.

8 You need not change any settings in Advanced. Most ISPs now use a dynamically 
assigned address. If the ISP you are connecting to does not use a dynamically-
assigned address, tap Advanced and then the TCP/IP tab, and enter the address. 
When finished, tap OK. 
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9 In the Make New Connection window, tap Next.
10 Enter the access phone number, and tap Next.
11 Select other desired options, and tap Finish.
12 In the Dialing Locations tab, specify your current location and phone type (most 

phone lines are tone). These settings will apply to all connections you create.

Starting a connection
To start the connection, simply start using one of the following programs. Your device will 
automatically begin connecting. Once connected, you can:

• Send and receive email messages by using Inbox. 
Before you can use Inbox, you need to provide the information it needs to 
communicate with the email server. 
For instructions, see "Connecting directly to an email server" on page 51. 

• Visit Web and WAP pages by using Pocket Internet Explorer. 
For more information, refer to page 53.

• Send and receive instant messages with MSN® Messenger. 
For more information, refer to page 60.

NOTE: A pop-up screen will appear once you begin connecting, and leave when the connection is 
complete.

Ending a connection 
To disconnect, do any of the following:

• When connected via cable or cradle, detach your device from the cable or cradle.
• When connected via Infrared, move your device away from the computer. 

• When connected via dial-up or VPN, tap the Connection icon  on your 
navigation bar, and then tap End. 

Connecting directly to an email server
You can set up a connection to an email server so that you can send and receive email 
messages by using a modem or network connection and Inbox on your device.

NOTE: The ISP or network must use a POP3 or IMAP4 email server and an SMTP gateway.

You can use multiple email services to receive your messages. For each email service 
you intend to use, first set up and name the email service. If you use the same service to 
connect to different mailboxes, set up and name each mailbox connection.

To set up an email service
1  In Inbox on your device, tap Services. 

For more information on using the Inbox program, go to page 57. 
2 Tap New Service. 
3 Follow the directions in the New Service wizard.

For an explanation of a screen, tap  and then Help. When finished connecting 
to your email server, tap Services and then Connect. 
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4 Fill out the email address field, then tap Next. 
This will initiate auto-configuration which attempts to connect your Pocket PC 
Phone to your email server and automatically download the necessary email 
connection settings. 
If auto-configuration is successful you can begin sending/receiving emails straight 
away. If unsuccessful you will need to manually enter the settings.

5 Fill out the following fields: Your name, User name, and Password, then tap Next.
6 From the drop-down menu select the service type that your email provider 

supports (POP3 or IMAP4).
7 Fill out the Name field for your email account, then tap Next.
8 Enter your email provider’s server name information for incoming and outgoing 

mail, then tap Finish.
For an explanation of a screen, tap  and then Help. 
To connect to your email server, tap Services and then Connect.

Getting help on connecting
More information on the procedures described here, as well as information on additional 
procedures, can be found in the following locations:

• The accompanying Settings Guide.
• The section on "Inbox" on page 57. 

• Online Help of your device. Tap  and then Help. Tap View, All Installed 
Help, and then Inbox or Connections.

• ActiveSyncTM Help on the your computer. In ActiveSyncTM, click Microsoft® 
ActiveSyncTM Help on the Help menu.
For troubleshooting information, see the Pocket PC Web site at 
(http://www.microsoft.com/mobile/pocketpc/). 
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7 Wireless data 
programs
Your ET180 Pocket PC Phone has built in support for a range of wireless data 
communication programs you can use to:

• Browse the Web and view WAP-enabled sites - use Pocket Internet Explorer 
(refer to page 53)

• Send and receive email/SMS messages - use Inbox (go to page 57)
• Send and receive instant messages - use MSN® Messenger (see page 60)
• Synchronize with your PC remotely - use ActiveSyncTM (refer to page 30)
• Send and receive information from another IR-compatible Windows-powered 

device - see page 49

 Using Pocket Internet Explorer
Use Pocket Internet Explorer to view Web HTML, cHTML, and WAP pages from your 
device in either of these ways:

• During synchronisation with your computer, download your favorite links and 
mobile favorites that are stored in the Mobile Favorites subfolder of Internet 
Explorer on your computer.

• Connect to an Internet service provider (ISP) or network and browse the Web. To 
do this, you'll need to create the connection first, as described in "6 Getting 
connected" on page 49.
When connected to an ISP or network, you can also download files and programs 
from the Internet or intranet. 

To open Pocket Internet Explorer
• Tap  and then Internet Explorer.

Hide pictures button
Favorites button

Home button
Refresh button
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To view mobile favorites and channels
1  Tap the Favorites button to display your list of favorites.

2 Tap the page you want to view. 
You'll see the page that was downloaded the last time you synchronised with your 
computer. If the page is not on your device, the favorite will be dimmed. You will 
need to synchronise with your computer again to download the page to your 
device, or connect to the Internet to view the page.

To browse the Internet
1  Set up a connection to your ISP or corporate network, as described in "6 Getting 

connected" on page 49.
2 To connect and start browsing, do one of the following:

• Tap the Favorites button, and then tap the favorite you want to view.
• Tap View and then Address Bar. In the address bar that appears at the top of 

the screen, enter the Web address you want to visit and then tap Go. Tap the 
arrow to choose from previously entered addresses.

• To add a favorite link while using your device: 
a Go to the page you want to add. 
b Tap and hold on the page.
c Tap Add to Favorites.

Mobile Favorites folder
Only items stored in the Mobile Favorites subfolder in the Favorites folder of Internet 
Explorer on your computer will be synchronised with your device. This folder was created 
automatically when you installed ActiveSyncTM. 

Tap to add or delete
a folder or favorite link.

Tap the favorite you
want to view.
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Favorite links
During synchronisation, the list of favorite links in the Mobile Favorites folder on your 
computer is synchronised with Pocket Internet Explorer on your device. Both locations 
are updated with changes made to either list each time you synchronise. Unless you 
mark the favorite link as a mobile favorite, only the link will be downloaded to your 
device, and you will need to connect to your ISP or network to view the content. 
For more information on synchronisation, see ActiveSyncTM Help on your computer.

Mobile favorites 
If you are using Microsoft® Internet Explorer 5.0 or later on your computer, you can 
download mobile favorites to your device. Synchronising mobile favorites downloads 
Web content to your device enable you to view pages while you are disconnected from 
your ISP and computer.
Use the Internet Explorer plug-in installed with ActiveSyncTM to create mobile favorites 
quickly.

To create a mobile favorite:
1  In Internet Explorer on your computer, click Tools and then Create Mobile 

Favorite.
2 To change the link name, enter a new name in the Name box. 
3 Optionally, in Update, select a desired update schedule.

NOTE: If you did not specify an update schedule, you will need to manually download content to keep 
the information updated on both your computer and device. Before synchronising with your device, in 
Internet Explorer on your computer, click Tools and then Synchronise. You will see the last time content 
was downloaded to the computer, and you can manually download content if needed.

4 Click OK. 
Internet Explorer downloads the latest version of the page to your computer.

TIP: You can add a button to the Internet Explorer toolbar for creating mobile favorites. In Internet 
Explorer on your computer, click View, Toolbars, and then Customise.

To download a mobile favorite: 
1  Right-click the mobile favorite and then click Properties. 
2 In the Download tab, specify the number of links deep you want to download. 

To conserve device memory, go only one level deep.
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3 Synchronise your device and computer. 
Mobile favorites that are stored in the Mobile Favorites folder in Internet Explorer 
are downloaded to your device.

To save device memory in downloading mobile favorites: 
Mobile favorites take up storage memory on your device. To minimise the amount of 
memory used, observe the following:

• In the settings for the Favorites information type in ActiveSyncTM options, turn off 
pictures and sounds, or stop some mobile favorites from being downloaded to 
your device. 

• Limit the number of downloaded linked pages. In Internet Explorer on the 
computer, right-click the mobile favorite you want to change and then click 
Properties. In the Download tab, specify 0 or 1 for the number of linked pages you 
want to download.

 AvantGo® 
AvantGo® is a free interactive service that gives you access to personalised content and 
thousands of popular Web sites. You subscribe to AvantGo channels directly from your 
device, then, you synchronise your device and computer, or connect to the Internet to 
download the content. 

Visit the AvantGo Web site at http://avantgo.com/frontdoor/index.html for more 
information.

Signing up for AvantGo
1  In ActiveSyncTM options on your computer, turn on synchronisation for the 

AvantGo information type.
2 In Pocket Internet Explorer on your device, tap the Favorites button to display your 

list of favorites.
3 Tap the AvantGo Channels link.
4 Tap the Activate button.
5 Follow the onscreen directions. 
6 To complete the setup, synchronise your device with your computer and then tap 

the My Channels button.
When synchronisation is complete, tap the AvantGo Channels link in your list of favorites 
to see a few of the most popular channels. 

To add or remove channels
• Tap the Add or Remove link.
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 Inbox
Use Inbox to send and receive email messages by doing either of the following: 

• Synchronise email messages with Microsoft® Exchange or Microsoft® Outlook on 
your computer.

• Send and receive email messages by connecting directly to an email server 
through an Internet service provider (ISP) or a network.

You also can use Inbox to send and receive SMS; it supports 8 bits data with class 0, 1, 
2, 3, as well as USDA (Unstructured Supplementary Service Data). 

To open Inbox

• Tap  and then Inbox. 
Inbox will open to the Inbox’ folder navigator.

Synchronising email messages
Email messages can be synchronised as part of the general synchronisation process. 
You will need to enable Inbox synchronisation in ActiveSyncTM. 
For information on enabling Inbox synchronisation, see ActiveSyncTM Help on your 
computer.
During synchronisation:

• Messages are copied from the mail folders of Exchange or Outlook on your 
computer to the ActiveSyncTM folder in Inbox on your device. By default, you will 
receive messages from the past three days only, the first 100 lines of each 
message, and file attachments of less than 100 KB in size.

• Email messages in the Outbox folder on your device are transferred to Exchange 
or Outlook, and then sent from those programs.

• Email messages in subfolders must be selected in ActiveSyncTM on your computer 
in order to be transferred.

TIP: You can also synchronise email messages with your computer from a remote location. For more 
information, see the ActiveSyncTM Help menu in your computer.

Connecting directly to an email server
In addition to synchronising email messages with your computer, you can send and 
receive email messages by connecting to an email server using a modem or a network 
card connected to your device. You'll need to set up a remote connection to a network or 
an ISP, and a connection to your email server. For more information, refer to "6 Getting 
connected" on page 49. 
When you connect to the email server, new messages are downloaded to your device’s 
Inbox folder, messages in the device’s Outbox folder are sent, and messages that have 
been deleted on the email server are removed from the device’s Inbox folder.
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Messages that you receive directly from an email server are linked to your email server 
rather than your computer. When you delete a message on your device, it is also deleted 
from the email server the next time you connect based on the settings you selected in 
ActiveSyncTM.
You can work online or offline. When working online, you read and respond to messages 
while connected to the email server. Messages are sent as soon as you tap Send, which 
saves space on your device.
When working offline, once you've downloaded new message headers or partial 
messages, you can disconnect from the email server and then decide which messages 
to download completely. The next time you connect, Inbox downloads the complete 
messages you've marked for retrieval and sends the messages you've composed.

Using the message list
The messages you receive are displayed in the message list. By default, the most 
recently received messages are displayed first in the list.

When you receive a message, tap it to open it. Unread messages are displayed in bold.

When you connect to your email server, by default, you'll receive messages from the last 
five days only, the first 100 lines of each new message, and file attachments of less than 
100 KB in size. The original messages remain on the email server or your computer. 

Select the sort order
for messages.

Select the service and folder
you want to display.

Tap to connect to
the selected service.

Tap to connect and to
send and receive e-mail.

Tap to open a message.

Tap and hold to display
a pop-up menu of actions.

Tap to delete this message.

Tap to view  the previous
or next message.

Tap to reply to or
forward this message.

Tap to return to
the message list.
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You can mark the messages that you want to retrieve in full during your next 
synchronisation or email server connection. Follow the steps below. 
1  In the message list, tap and hold the message you want to retrieve. 
2 On the pop-up menu, tap Mark for Download. The icons in the Inbox message list 

give you visual indications of message status.
Specify your downloading preferences when you set up the service or select your 
synchronisation options. You can change them at any time:
• Change options for Inbox synchronisation using ActiveSyncTM options. For 

more information, see ActiveSyncTM Help.
• To change options for direct email server connections. In Inbox on your 

device: 
a Tap Tools and then tap Options. 
b On the Service tab, tap the service you want to change. 
c Tap and hold the service and select Delete to remove a service.

Creating an email/SMS message
1  In the command bar, tap New. 
2 In the To field, enter an email or SMS address of one or more recipients, 

separating them with a semicolon, or select a name from the contact list by 
tapping the Address Book button. 
All email addresses entered in the email fields in Contacts appear in the Address 
Book.

3 Compose your message. 
To enter preset or frequently used messages, tap the My Text menu, then select a 
message.
If you are sending an SMS message and want to know if it was received, tap the 
Edit menu, select Options, then select the Request SMS text message delivery 
notification check box. 

4 Tap Send when you've finished the message. 
If you are working offline, the message is moved to the Outbox folder and will be 
sent the next time you connect.

NOTE: Whether you want to send or read an email or SMS message, you do so by changing the 
Services option. To do so, tap the double arrows next to the Subject field, then tap the Services field to 
choose what service you want. 

Tap to show or hide
the complete header.

Tap to send the message.

Tap to insert common messages.

Tap to show / hide the
recording toolbar.

Tap to display the Address Book.
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Managing email messages and folders
By default, messages are displayed in one of five folders for each service you have 
created: Inbox, Deleted Items, Drafts, Outbox, and Sent Items. 

• The behavior of the Deleted and Sent Items folders depends on the options you 
have chosen. To set these options, in the message list: 
a Tap Tools and then Options. 
b On the Message tab, select your options.

• If you want to organise messages into additional folders, tap Tools, and then 
Manage Folders to create new folders. 

• To move a message to another folder, in the message list, tap and hold the 
message and then tap Move to on the pop-up menu.

Folder behavior with a direct connection to an email server
The behavior of the folders you create depends on whether you are using ActiveSyncTM, 
SMS, POP3, or IMAP4. 

• If you use ActiveSyncTM, email messages in the Inbox folder in Outlook will 
automatically be synchronised with your device. You can select to synchronise 
additional folders by designating them for ActiveSyncTM. The folders you create 
and the messages you move will then be mirrored on the server. For example, if 
you move two messages from the Inbox folder to a folder named Family, and you 
have designated Family for synchronisation, the server creates a copy of the 
Family folder and copies the messages into that folder. You can then read the 
messages while away from your computer.

• If you use SMS, messages are stored in the Inbox folder. 
• If you use POP3 and you move email messages to a folder you created, the link is 

broken between the messages on your device and their copies on the email 
server. The next time you connect, the email server will see that the messages 
are missing from the device’s Inbox and delete them from the server. This 
prevents you from having duplicate copies of a message, but it also means that 
you will no longer have access to messages that you move to folders created from 
anywhere except your device. 

• If you use IMAP4, the folders you create and the email messages you move are 
mirrored on the server. Therefore, messages are available to you anytime you 
connect to your email server, whether it is from your device or from your 
computer. This synchronisation of folders occurs whenever you connect to your 
mail server, create new folders, or rename/delete folders when connected. 

 MSN® Messenger
MSN® Messenger on your device is an instant messaging program that lets you:

• See who is online
• Send and receive instant messages
• Have instant message conversations with groups of contacts

For more information on using MSN® Messenger, tap  > Programs > MSN Messenger 
then, tap Help from the  menu.

Requirements to use MSN® Messenger
• Microsoft® Passport™ account or a Microsoft® Exchange email account. 
• Passport to use MSN® Messenger Service. If you have a Hotmail® or MSN® 

account, you already have a Passport. 
Once you have obtained either a Microsoft® Passport or a Microsoft® Exchange account, 
you are ready to set up your account.

TIP: Sign up for a Microsoft® Passport account at (http://www.passport.com/). Get a free Microsoft® 
Hotmail email address at (http://www.hotmail.com/).
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Setting up an account
Before you can connect, you must enter Passport or Exchange account information.

To set up an account and sign in
1  In the Tools menu, tap Options.
2 In the Accounts tab, enter your Passport or Exchange account information.
3 To sign in, tap the sign-in screen and enter your email address and password.

NOTE: If you already use MSN® Messenger on your computer, your contacts will show up on your 
device without being added again.

To switch to MSN® Messenger
• Tap , Programs, and then MSN Messenger.

Working with contacts
The MSN® Messenger window shows all of your messenger contacts at a glance, divided 
into Online and Not Online categories. From this view, while connected, you can chat, 
send a email, block the contact from chatting with you, or delete contacts from your list 
using the pop-up menu.

• To see others online without being seen, in the Tools menu, tap My Status and 
select Appear Offline. 

• If you block a contact, you will appear offline but will remain on the blocked 
contact list. 

• To unblock a contact, tap and hold the contact, then tap Unblock on the pop-up 
menu.

Chatting with contacts
1  Tap a contact name to open a chat window. 
2 Enter your message in the text entry area at the bottom of the screen, or tap My 

Text to enter a preset message. 
3 Tap Send.

Tap and hold to display
a pop-up menu of actions.

Tap a contact to start a chat.
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Tips when chatting with contacts
• To invite another contact to a multi-user chat, in the Tools menu, tap Invite and 

tap the contact you want to invite.
• To switch back to the main window without closing a chat, tap the Contacts 

button. 
• To revert back to your chat window, tap Chats and select the person whom you 

were chatting with.
• To know if the contact you are chatting with is responding, look for the message 

under the text entry area.

 Terminal Services Client
You can use Terminal Services Client to log onto a Windows NT server type PC that is 
running Terminal Services software and use all of the programs that are available on that 
PC from your device. For example, instead of running Microsoft® Pocket Word, you can 
run the PC version of Microsoft® Word and access all of the .doc files on that PC from 
your device.

NOTE: You cannot use Transcriber when entering information in Terminal Services. You must use 
Keyboard, Block Recognizer, or Letter Recognizer.

Connecting to a terminal server
1  Start a remote connection to the server via your wireless modem connection.

2 Tap , Programs, and then Terminal Services Client .
The Terminal Services Client main window appears. 

Enter message.

Tap to send message.
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3 To connect to a server you have previously connected to, in Recent Servers, tap a 
server.
To connect to a new server, enter the server’s name in the Server box. 

NOTE: Select the limit size of desktop to fit on the screen check box only when using applications that 
have been specifically sized for use with Pocket PC.

4 Tap Connect.

NOTE: If the network administrator has configured Terminal Services Client to reconnect to 
disconnected sessions, and you previously disconnected from a Terminal Server without ending the 
session, the Terminal Services Client reconnects to that session.

To disconnect without ending a session
The following commands must be accessed from the Start menu in the Terminal Services 
window used to access the PC’s commands. Do not use the Start menu on your mobile 
device.

1  In the Terminal Services Client window, tap , and then Shutdown.
2 Tap Disconnect.

NOTE: If the network administrator has configured Terminal Services Client to reconnect to 
disconnected sessions, you will be reconnected to this session the next time you connect to this server.

To disconnect and end a session

1  In the Terminal Services Client window, tap  and then Shutdown.
2 Tap Log Off.

To navigate inside Terminal Services Client
Once connected to the server, the PC’s screen may more than fill your device’s screen. 

• If scroll bars are displayed on the server’s screen, you will see more than one set 
of scroll bars on your device—one to scroll information on the PC, and the other 
one to scroll the PC display through the Terminal Services window in Terminal 
Services Client.

• To ensure you are scrolling the PC display through Terminal Services Client, use 
the four directional buttons at the bottom of the Terminal Services Client screen.

• To better-fit information on your mobile device’s screen, select Limit size of server 
desktop to fit on this screen. For best effect, programs on the PC should be 
maximized.
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Tips when using Terminal Services Client
To improve display performance
Display performance is improved by decreasing the time it takes for the screen to be 
refreshed on the PC.

1  On your PC, select , Settings, then Control Panel.
2 Click Display.
3 Deselect the “Clear the Transition effects for menus and tool tips” check box.

To improve browser performance
The level of Internet Explorer’s performance on your PC is improved by decreasing the 
time it takes for Web pages to be refreshed.
1  In Internet Explorer on your PC, select Tools > Internet Options > Advanced. 
2 Deselect the “Use smooth scrolling” check box.
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8 Using Phone
The fully integrated phone functionality of your ET180 boasts of standard cell phone 
features—such as mailbox and call log—as well as all several handy call features 
including Call Waiting, Caller ID, Call Forwarding, and Conference Calling. And because 
the function is integrated with your device’s PDA functions, managing contact information 
between Phone and other applications is as easy as it gets. For your convenience, the 
callpad and keypad modules let’s you enjoy the one-hand operation of using 
conventional mobile phones.

NOTE: The keypad module is not included in the ET180 package contents; you need to purchase 
this item separately.

Installing the SIM card
If you wish to use your device phone application, you need to first install a valid SIM card. 
You need to separately purchase the SIM card; the card is not included in the ET180 
package contents. 

To install the SIM card
1  If the device is switched on, turn it off by pressing the power button on the front 

panel. 
2 Turn over the device so that rear panel faces you. 
3 If the battery pack is installed, remove it. Go to page xi for instructions.
4 Perform the following steps. 

(1) Slide the SIM card holder to the right. 
(2) Lift the holder halfway from the recess area. 
(3) Insert the SIM card into SIM card holder.

Note the proper position of the SIM card—the card connector (i.e., gold area) 
should be facing downward with the bevelled corner fitting the lower-left corner 
of the recess area.

(4) Press the SIM card holder down. 
(5) Slide the SIM card holder to the left to lock it into place.
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5 Reinstall the battery pack. 
Go to page xi for instructions.

NOTE: The device will automatically turned the Phone application on every time you install a SIM 
card.

The default settings for your device are programmed on the assumption that you’ll be 
using the phone function so once you’ve properly installed a SIM card (and in some 
cases, entered a PIN), you can then proceed to establishing a connection to your mobile 
service provider’s network. For more information, refer to ‘Turning the phone function on 
and off’ on page 69. 

NOTE: If you’re not going to install a SIM card on your device, keep the phone function off to minimize 
power consumption. 

Entering your PIN
After you have installed the SIM card you’ll be able to activate your mobile service 
connection. In most cases, SIM cards are preset with a PIN (Personal Identity Number), 
provided by your mobile service provider, which you need to enter to establish mobile 
service connection. 

To enter your PIN
1  Tap , then Phone. 
2 On the Dialer screen, enter the preset PIN from your mobile phone service 

provider. 

3 Tap .
If you consecutively enter a wrong PIN for three times, the SIM card will be blocked. If 
that happens, you can unblock it with the PIN Unblocking Key also provided by your 
mobile phone service provider.

About the Dialer screen
Launching Phone opens the Dialer screen. To do this you can do either of the following:

• Tap , then Phone. 
• If the callpad module is attached, press the Send button .
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Dialer buttons
The table below lists the actions of the Dialer screen buttons. 

Phone status icons
The icons on the table below maybe seen on the navigation bar when the phone function 
is enabled.  

Soft keypad for inputting 

The last number called
is displayed here.

Tap Tools > Options to 
view phone settings.

This icon indicates a call is being made 
and the strength of the signal.

Tap to view the Call Log entries. 

Tap here to create a note.

Tap to back space over 
individual numbers.

Tap to view the Speed Dial list. 

Icon Description 

Tap to make a phone call.

Tap to erase the number you entered. 

Tap to end a call.

Tap during a call to create a a note for that particular call.

Tap to view the Speed Dial list.

Tap to see all calls received, made, and missed.

Icon Name Description 

Phone off or out 
of network service

Tap to turn on the phone

In network service Tap to turn off the phone.

Signal status The number of bars indicates the strength of 
your connection signal. As the strength of the 
signal diminishes so will the number of bars in 
the icon, with no bars indicating no signal.
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About the callpad module
Your device comes with a detachable callpad module that contains the Send and 
End  buttons for making and sending calls and SMS messages from your device. 

Callpad buttons
The Send and End  buttons of the callpad module performs different actions 
depending on when or from which screen did you pressed it.

Send button actions
The Send button  performs the following actions: 

• When there’s an incoming call, press to accept the call. 
• During an ongoing call, press and hold to toggle on/off the speakerphone mode. 
• From the Dialer screen, press to call the currently displayed number. 
• In mailbox, press to send a composed email/SMS message or display options for 

a received email/SMS.
• From a PDA application, press to display the Dialer screen or press twice to redial 

the last called number. 

End button actions
The End button  performs the following actions:

• When there’s an incoming call, press to reject the call. 
• During an ongoing call, press to end the call.
• When manually dialing a number, press to delete the number input.
• Press and hold to toggle on/off the mobile service connection.

Phone operation
This section explains the procedures for basic phone operations including how to: 

• Toggle the phone function on and off
• Erase or delete number input
• Accept or reject calls
• Adjust the phone conversation volume
• Toggle the speakerphone mode on and off
• End calls

Active call Notifies you that a call is being made or there is 
an incoming call.

Speakerphone Indicates that the speakerphone mode is 
enabled. For more information on the 
speakerphone mode, refer to page 71.

Call missed Tap to view the call(s) you missed.

Unread email or 
SMS

Tap to view unread SMS or email message(s). 

Voice mail 
notification1

Tap to access new voice mail message (s). For 
more information on the voice mail function, 
refer to page 80. 

1 Voice mail service is dependent on your mobile service provider’s network. 

Icon Name Description 

Download from Www.Somanuals.com. All Manuals Search And Download.



8 Using Phone
Phone operation

69

Turning the phone function on and off 
If you have turned the phone function off, removed and then reinstalled the SIM card, the 
connection to your mobile service provider’s network is not automatically enabled. You 
have the option to just use the device’s PDA features or you can reestablish the mobile 
service connection. 

IMPORTANT: In many countries it is required by law to turn off cell phones when boarding commercial 
flights. Turning off your ET180 Pocket PC Phone does not turn off the device’s phone function; you must 
disconnect the mobile service connection. 

To turn on the phone function 
• Press and hold the End button  on your device until appears in the 

navigation bar.
- or - 
Tap  and then select Turn phone on from the pop-up screen.

To turn off the phone function 
• Press and hold the End button  on your device until  appears in the 

navigation bar. 
- or- 
Tap  and then select Turn phone off from the pop-up screen.

Backspacing and deleting number input
If you entered a wrong phone number when dialing, you can either backspace to erase 
individual digits or you can delete the entire phone number. 

To backspace over digits
• Tap . 

To delete the phone number entry
• From the command bar, tap Edit > Clear or tap and hold .

Tap to back space and 
erase numbers individually.

Tap here to delete the entire 
phone number entry. 
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Responding to phone calls
You can either accept or reject a call. 

To answer a call
• Tap Answer. (, or press the Send button . 

To reject a call
• Tap Ignore. (or press the End button .)

If you reject a call a busy tone will be sent out.

Adjusting the phone conversation volume
To adjust the phone conversation volume, you must do it during a call. If you adjust the 
volume at another time it will only affect the level of the system sounds (i.e., ring and 
notification alerts, .wmv/MP3 playback). 

To adjust the phone conversation volume
You can either:

• Tap  on the navigation bar to bring up the Volume callout, then drag the slider 
up/down.

-or- 
• Press the volume rocker key up/down. 

The Volume callout will also appear to display the volume level. 
For the location on the volume rocker key, refer to the ‘Left view’ section on 
page 7.
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Toggling the speakerphone mode on and off
Your device’s speakerphone function allows you to talk hands-free and/or let other 
people listen to the caller.

To enable the speakerphone mode

WARNING! To prevent damaging your ear, do not hold the device to your ear while the speakerphone 
mode is enabled.

1  Wait until the phone is ringing.

2 Press and hold the Send button  until the speakerphone comes on indicated 

by the appearance of  in the navigation bar.

To disable speakerphone mode
• Press and hold the Send button  again or tap  on the navigation bar. 

Ending phone calls
You can end an incoming or outgoing call. 

To end a call
• On the Dialer screen tap , or press the End button .

Making phone calls
The integrated nature of your device’s phone function lets you make calls in a variety of 
ways across different applications. You can make a call by:

• Manually entering a phone number using the Dialer keypad or the keypad module.
• Accessing numbers using Speed Dial, Call Log, Microsoft Contacts or SIM 

Manager. 
Once a call has been initiated this icon  on the navigation bar changes to . 

NOTE: In the succeeding sections, it is assumed that for steps that require pressing callpad buttons or 
keys in the keypad module, the corresponding modules are attached to the device. 

Making a call from Dialer
1  On the Dialer keypad, tap the phone number you want to call. 
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2 Tap  or press the Send button .

Making a call using the keypad module
1  In the keypad module, punched in the phone number you want to call. 

2 Press the Send button . 

International calls
For making a call to an overseas number that is not stored either in your SIM card or in 
your device, follow the steps below using the Dialer keypad or the keypad module. 
1  Tap and hold/press the ‘0’ key until the ‘+’ sign appears. 

‘+’ replaces the international number prefix ‘00’. 
2 Enter the full phone number you want to dial.

It includes the country code, area code (without the leading zero), and phone 
number.

3 On the Dialer screen tap or press the Send button .

Making a call using Microsoft Contacts
Contacts is a Pocket Outlook® application which lets you maintain a list of your friends’ 
and colleagues’ contact information. For detailed information in how to use this 
application, go to page 33.

To make a call using Microsoft Contacts

Tap the number you 
wish to dial here.

This icon indicates a call is being 
made and the strength of the signal.

The number being called
is displayed here.

Tap to view the Call Log entries. 

Tap to view the Speed Dial list
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You can make a call in two ways. On the Contacts window, find the contact then:

• Press the Send button twice—once to launch Phone and another to make 
the call.

• Tap and hold the “w” in the right column next to the contact you want to call. 

NOTE: If instead of ‘w’, ‘e’ is displayed on the column, tap ‘w’ then on the pop-up menu tap E-mail.

On the pop-up menu, phone numbers for this contact is displayed, with a dot next 
to the priority number. Tap which number to call. 

Making a call using Speed Dial 
Speed Dial is a list you create for number you regularly call. Only numbers stored in 
Microsoft Contacts can be added to this list. For instructions, go to ‘To export contacts 
from Microsoft Contacts’ on page 81.

To make a call using Speed Dial
You can make a call in two ways:

• By memorizing the position in the Speed Dial list of a number, you can dial the 
number by entering its location number. 
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•

In the picture above, Lynn Tseng is at position 7. To dial his number, tap and hold 
7 on the Dialer keypad. 
If a number holds a position of 10 or more tap the first number, and then tap and 
hold the second to dial.

• Alternatively, if you don’t remember the position of a number in the Speed Dial list 
follow the steps below:
a On the Dialer screen, tap  or rotate down the jog dial. 
b On the Speed Dial window, use the jog dial to go through the list to find the 

number you want to call.
c Once the number is selected, you can either press the jog dial or the Send 

button to initiate the call. 

Making a call using Call Log
Call Log is a record of all incoming, outgoing, and missed calls. For more information on 
this feature, go to page 84. 

To make a call using Call Log
To make a call: 

1  On the Dialer screen, tap  or rotate up the jog dial. 

Tap to edit contact details.

Tap to add a contact to
Speed Dial.

Tap to adjust voice mail settings.

Tap to
place

call.
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2 Use the jog dial to find the number you want to call. 
You can select a call category— All Calls, MIssed, Outgoing, Incoming, and 
By Caller, by tapping the pick list in the top-left corner of screen. 

3 Once the number has been selected, either using the jog dial selection or by 
tapping it, make the call by doing any of the following: 

• Press the jog dial. 

• Press the Send button . 
• Tap the category icon on the left of the selected log item. 

Refer to page 85 for more information on Call Log category icons. 

Making a call from SIM Manager
SIM Manager is a program you can use to view, add, and transfer the contents of your 
SIM card. For more information on this program, go to ‘Managing contacts using SIM 
Manager’ on page 82. 

To make a call from SIM Manager
To make a call: 

1  Tap , Programs, and then tap SIM Manager . 
Wait for the SIM card contents to load.

2 Use the jog dial to find the number you want to call. 

Tap here to select a call category.
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3 Once the number has been selected, using the jog dial selection or by tapping it, 
make the call by doing any of the following: 
• Press the jog dial. 
• Press the Send button . 
• Tap and hold the selected number, then select Call from the pop-up menu.

Emergency call 
Your ET180 Pocket PC Phone supports the international emergency number 112. You 
can call this number to make an emergency call in any country, with or without a SIM 
card1 installed in your device, as long as a mobile phone service network is available in 
your area. 

NOTE: In some cases, additional local emergency numbers may be provided by your mobile phone 
service provider. 

To make an emergency call
1  Enter the international emergency number 112, either in the Dialer keypad, or in 

the keypad module. 

2 On the Dialer screen, tap  or press the Send button .

Managing more than one call
Flexibility is a hallmark of your device’s phone function. This is manifested in such 
features as Call Notification, Call Hold and Conference Call, which allows you to attend 
to more than one call simultaneously—all with a simple tap of your stylus. 

Call Notification 
The Call Notification feature lets you know if another person is trying to call you when 
you are talking on the phone. When this happens the following callout appears.

1Some mobile phone service providers may require that a SIM card is inserted, and in some cases that the
PIN has been entered as well, before you can call the emergency number. 
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Call Hold
After being notified of an incoming call while attending to an earlier one, you can choose 
to reject a call by tapping the Ignore button on the Phone - Incoming callout, or you can 
use the Call Hold feature to attend to both calls. 

To put a call on hold
• On the Call Notification callout, tap the Answer button to take the incoming call 

and put the original one on hold.

To swap between calls
• You can choose to swap backwards and forwards between two callers by tapping 

 on the Dialer screen.  

Conference Call
With the Conference Call feature you can create a conversation line between several 
callers.

To set up a conference call
1  You can either, put a call on hold, then dial a second number and wait for it to be 

picked up. Or, accept a second incoming call when you already have one in 
progress.

2 On the Dialer screen that appears tap .

Tap to swap between calls. 

Indicates which number is on hold.
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If the conference connection is successful the word Conference will appear in the 
input area of the Dialer screen. 

To add additional people to a conference call
You can connect up to six (6) callers at a time in a conference call.

1  On the Dialer screen, tap . 
2 Key in the new number. 
3 Tap Resume to return and continue with the conference call.

Other Phone functions
In addition to making and receiving phone calls, Phone also provides features for 
creating call notes; receiving and sending SMS/email messages; and retrieving voice 
mails. 

Call notes
Regardless of how you made a call—manually or using any of the call features, you have 
the option to create a note during a call. The call note will be saved as an attachment to 
your call as viewed in Call Log. 

To create a call note
1  During an outgoing call, tap the Note icon  located on the command bar. 

Tap here to set up a conference call. 
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2 In the Notes window, use any of the input methods to compose your call note.

Refer to ‘2 Entering data in your ET180’ on page 17 for more information on input 
methods.

3 After you finished your call note, tap OK. 

NOTE: You can finish your note during or after a call.

To view a call note
You can view call notes either from the Call Log window or from the Notes program. 

From the Call Log window:
1  On the Dialer screen, tap  or rotate up the jog dial to access Call Log. 
2 From the All Calls or Outgoing category in Call Log, select a log item marked with 

this icon —indicates that a note was created for this particular call.

For information on Call Log categories, refer to page 85. 
3 Tap and hold the selected log item, then tap View Note from the pop-up menu. 

From Notes:
• In the Notes window, tap a Call Log file from the list. 

For more information, go to ‘Notes’ on page 37. 

Tap this icon to view a call note. 
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SMS service
Just like a regular mobile phone, you can send SMS messages in your device using the 
Dialer screen’s Tool menu which is integrated with Inbox. 
For more information on using Inbox, go to page 57.

To send SMS using Dialer 
1  On the Dialer screen’s navigation bar, tap Tools > Send SMS.

Inbox will be launched displaying a new message window. 

2 Tap the double arrows next to the Subject field. 
3 Tap the Services field then select SMS. 
4 Fill out the To field, by either of the following methods: 

• Enter an SMS number of one or more recipients, separating them with a 
semicolon.

• Tap the Address Book icon on the navigation bar then select a contact from 
the list. 

5 Compose your message. 
To enter preset or frequently used messages, tap the My Text menu, then select a 
message.
If you are sending an SMS message and want to know if it was received, tap the 
Edit menu, select Options, then select the Request SMS text message delivery 
notification check box. 

6 Tap Send when you've finished the message. 
If you are working offline, the message is moved to the Outbox folder and will be 
sent the next time you connect.

Voice mail
With the voice mail service 2 you need not miss a message when you miss a call. 
Unattended calls (i.e., no answer, phone is turn off or is out of network service) or a busy 
line would automatically forward callers to your voice mailbox where they will be able to 
leave their messages. 
When you insert your SIM card into your device, it will automatically detect and set as 
default the voice mailbox number provided by your mobile service provider. By default, 
the first Speed Dial location is assigned to your voice mailbox. 

2Voice mail service is dependent on your mobile service provider’s network. 
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To retrieve your voice mails
• Tap and hold on the Dialer keypad. 

Managing contact information 
Your device’s phone capabilities are integrated with other applications making it easy for 
you to share contacts—phone number information—between programs. 

Places where contacts can enter your device and be stored
• Your SIM card 

You interchange your SIM card between your ET180 Pocket PC Phone and 
another device; while using the other device you create one or more new contacts 
on the SIM card.

• Microsoft Contacts 
For more information, go to ‘Contacts’ on page 33

• Call Log
New contact numbers can be found in incoming or missed calls.

Managing contacts using Microsoft Contacts
Below are several advantages for transferring contact information to Microsoft Contacts: 

• As a backup in case you lose your SIM card while using it with another device.
• If you are using your SIM with another device, you may need the numbers stored 

in Microsoft Contacts.
• Transferring numbers to Microsoft Contacts allows you to create a more detailed 

record.

NOTE: Transferring contacts from one location to another (e.g. from Microsoft Contacts to your Speed 
Dial list) does not delete the information on the original location. 

To add contacts to Microsoft Contacts
You can choose to create new contacts or add contacts from SIM Manager or from Call 
Log.

• For instructions on creating new contacts, go to page 34.
• For instructions on adding Call Log items, go to page 86. 
• For instruction on adding SIM Manager contacts, go to page 83.

To export contacts from Microsoft Contacts
You can choose to transfer entries in Microsoft Contacts to either your SIM card or to 
your Speed Dial list. 
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1  You can either: 
• Tap and hold a contact.
• Select a contact to select it, then from the command bar, tap the Tools menu.
If you do not select a contact, the first entry on the list will be transferred.

2 From the pop-up menu, select where to transfer the contact. 

• To transfer contact to your SIM card:
a Tap Save To SIM. 

A screen appears to display the transfer status. 
b After completing the transfer, tap OK. 

• To transfer contact to Speed Dial:
a Tap the Add Speed Dial... option. 

A screen appears to display the transfer status. 
b In the next screen add the contact details. 
c Select a location. 

By default the Location function will give you the next available position in 
the Speed Dial list. If you want to put a number in a position that is already 
occupied, the new number will overwrite the number already there.

d Tap OK.

Managing contacts using SIM Manager
The SIM Manager program lets you manage all contacts stored in your SIM card with the 
option to export this information to Microsoft Contacts.

To access SIM Manager: 
• Tap , Programs, and then tap SIM Manager . 

Wait for the SIM card contents to load.

To add contacts to SIM Manager
1  Tap New on the command bar.
2 In the Add Entry box, fill out the Name and Phone fields.
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3 Tap Add.

To export SIM Manager contacts 
You can choose to transfer individual SIM Manager contacts or transfer all contacts to 
Microsoft Contacts. 

To export individual SIM Manager contact: 
1  Tap and hold a contact, then from the pop-up menu, select Save to Contacts.

A pop-out message will confirm transfer to Microsoft Contacts. 
2 Tap OK to close the box.

To export all SIM Manager contacts: 
1  Tap Tools from the command bar, then select Save All To Contacts.
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A screen appears to display the transfer status. 
2 After completing the transfer, tap OK. 

Saving personal numbers to SIM Manager
You can choose to save your personal phone numbers in a separate screen in SIM 
Manager.

Managing the Call Log items
Call Log is a record of all incoming, outgoing, and missed calls. You can refer to it to 
check call details as well as access any notes taken during a call.
For instructions on making calls from Call Log, go to page 74.

To access the Call Log
• On the Dialer screen, tap  or rotate up the jog dial. 

Tap and hold icon to
display Note options.

Tap to view call details.

Tap to
place

call.

Tap to select the type
of calls to display.
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Call Log categories
Entries in the Call Log are grouped into five categories which include: 

Call duration
You can also check the duration of a call in Call Log.

To view call duration 
• Find the call you are interested in, then tap it once.

Call Log limit
To minimize the storage memory occupied by the Call Log items, you can set a limit for 
the number of entries retained after a specific period of time. 

To set the Call Log limit 
1  From the command bar, tap Tools > Options. 
2 On the Options window, tap the Delete call log items older than pick list. 

Icon Category Description 

All Calls Shows all calls made to and from the phone in 
chronological order

Missed Only shows calls that were not answered

Outgoing Only shows calls made from the phone

Incoming Only shows calls made to the phone

By Caller... Shows all calls made to and from the phone in 
alphabetical order based on the caller’s ID. 
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3 From the drop-down box, tap a time period option. 

4 Tap OK.

Transferring Call Log entries to Microsoft Contacts
You have the option to transfer new numbers under the Incoming and Missed log 
categories to Microsoft Contacts. 

To transfer Call Log entries to Microsoft Contacts
1  Tap and hold the number you want to transfer. 
2 In the pop-up menu that appears select New Contact.

3 On the Contact screen add additional contact details. 
4 Tap OK or press the jog dial.

The call details in the Call Log for the transferred number will be amended to 
display the contact name specified. 

Deleting Call Log entries
You can choose to delete individual call log entries or delete all logged items. 
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To delete individual Call Log entries 
• Tap and hold the entry you want to delete, then from the pop-up menu, select 

Delete.

To delete all Call Log entries
• From the command bar, tap Tools > Delete All Calls.

Customizing the phone functions
You can configure most features of your phone application to suit your preferences. You 
do this by accessing the Phone option under Settings. 

To access Phone Settings
Do either of the following: 

• From the Dialer screen’s command bar, tap Tools > Options.

• From any other screen, tap , then Settings. On the Personal tab, tap the 

Phone icon . 
The Phone settings window has four tabs—Phone, Services, Network, and Special. 
Refer to the succeeding sections for configuration options available for each tab.
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Settings - Phone tab
Configure sound and security settings in this tab. The SIM card number is indicated on 
the first line of this page.

NOTE: If you are going to use multiple SIM cards, you need to soft reset your device to update the 
phone number displayed on the Settings - Phone tab. 

To configure ring type, ring tone, and keypad sounds
• Under the Sounds option, tap the pick list for each setting, then select your choice 

from the drop-down menu. 

Downloading ring tones
For a more personalize ring tone, you can choose to download .wav files to your device 
in a variety of ways: 

• Via synchronization using ActiveSyncTM - go to page 29
• Via Internet access using Pocket Internet Explorer - go to page 53
• Via IR transfer - go to page 49

NOTE: Only .wav format sound files can be used as ring tones. 

Managing ring tones

• Tap , then Settings. On the Personal tab, tap the Preference icon .
The program will automatically list and display all the .wav files on your device. A 
marked check box besides a file indicate that it has been added to the Ring Tone 
selection box under Phone Settings.

Ring type

Ring tone

Keypad sound
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To play a ring tone:
• Tap the ring tone file you want to play to select the check box beside it, then 

tap . To stop ring tone playback, tap . 

To add a ring tone to Phone Settings:

• Tap the ring tone file you want to add, then tap . 

To remove a ring tone from Phone Settings:
• Tap the ring tone file you want to remove to deselect the check box beside it, then 

tap . 

NOTE: You can add and remove several ring tone files simultaneously. 

To configure your PIN
Under the Security options, you can change your PIN and have it enabled or disabled. 

To enable your PIN:
• Select the Require PIN when phone is used check box. 

To disable your PIN:
• Deselect the Require PIN when phone is used check box.

To change your PIN:
1  Tap the Change Pin button. 
2 Enter the old pin, input a new one, then retype it for confirmation.

Tap here to enable 
or disable PIN.

Tap here to modify 
your PIN. 
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Settings - Services tab
Configure the different phone services in this tab. 

Caller ID
When you place a call, your phone number will be revealed to the person that you are 
calling. 

To enable or disable Caller ID:
1  Tap Caller ID from the services list. 
2 Tap the Get Settings button (retrieving settings may take a few minutes).
3 In the next screen, you can either tap the radio button for: 

• Everyone I call - to enable Caller ID, or
• Never provide caller ID - to disable Caller ID

4 Tap OK.

Call forwarding
This service allows you to forward incoming calls to another phone number. You can 
choose to forward all calls to the same number or specify a number based on the 
following conditions: 

• Unavailable - your phone is turned off or your phone is out of network service
• Busy - when you are on the phone
• No answer - if you do not answer your phone

To enable or disable call forwarding:
1  Tap Call forwarding from the services list. 
2 Tap the Get Settings button (retrieving settings may take a few minutes).
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3 In the next screen, follow the following steps to enable or disable call forwarding:

• To enable call forwarding
– Tap the Forward all incoming calls check box, then specify the call 

forward phone number on the To field. 
– Tap the check box for one or all particular conditions, then specify the 

call forward phone number on the box opposite it. 
• To disable call for forwarding, deselect all the check boxes. 

4 Tap OK.

Call waiting
This service allows you to receive another call during an active call.

To enable or disable call waiting:
1  Tap Call waiting from the services list. 
2 Tap the Get Settings button (retrieving settings may take a few minutes).
3 In the next screen, you can either tap: 

• Notify me - to enable call waiting, or
• Do not notify me - to disable call waiting

4 Tap OK.

Voice mail and SMS
By default your device will automatically detect and set the voice mail and SMS access 
numbers provided by your mobile service provider. You can view these numbers for your 
reference. 

To view voice mail and SMS access numbers:
1  Tap Voice mail and SMS from the services list. 
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2 Tap the Get Settings button (retrieving settings may take a few minutes).

Settings - Network tab
Configure settings related to mobile service networks in this tab. The currently activated 
network is indicated on the first line of this tab.

To find a network
Activate this function when the network status is currently out of network service and you 
want to conduct a search. 

• Tap the Find Network button (search process may take a few minutes).

To select a network
Set the mode for conducting a network search. 

• Under Network selection, tap either Automatic or Manual.

NOTE: Retrieving network settings may take a few minutes if you select Manual.

To set preferred networks
If there are many mobile phone service providers available in your area, you can 
configure this function to select your preferred ones and set its priority level. 

Tap here to find a network. 

Tap here to set priority network. 
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1  Under Network selection, tap the Set Preferred Networks button. 
The screen below appears (retrieving settings may take a few minutes).

2 To include a listed network as a preferred network, tap the check box opposite it. 
3 To set the priority level, tap a preferred network, then tap the Move Up/Move 

Down buttons. 

Settings - Special tab
Configure the manner by which calls are accepted and/or terminated when the optional 
keypad module is attached to your device in this tab.

• Select the Any Key Answer check box to accept an incoming call by pressing any 
button on the keypad module. 

• Select the Auto Pickup check box to accept an incoming call after a specified 
number of rings without pressing any hardware or software button. Options 
include auto pickup after 5, 6, 7, 8, 9, or 10 rings. 

• Select the last check box to accept and/or terminate calls without pressing any 
keypad button. To accept an incoming call, simply flip the module open; to 
terminate an active call, flip the module close. 
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9 Customising your 
ET180
You can customise your ET180 based on your personal requirements and preferences 
as well as depending on your usual work modes. Customise your device by doing either 
of the following: 

• Adjust the device settings
• Add or remove programs

Adjusting device settings
You can adjust the settings of your device to suit the way you work.

To access Settings
• Tap , then Settings. 

The Settings window has three tabs—Personal, System, and Connections, each of 
which has its own set of options. 
The succeeding sections show the configuration page of each the Settings options. For 
detailed instructions on these pages, access the page from your device, tap , then 
Help. 

Personal
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 Buttons
Assign commonly-used application programs to any of the hardware buttons.

 Input
Select an input method, options for word completion and other related settings.

 Menus
Customise what appears on the  menu, and enable a pop-up menu from the New 
button.
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 Owner Information
Enter personal information and customise text display when device is turned on. 

 Password
Set a password to prevent unauthorized access to your device.

 Phone
Set up the phone function of your device. For more information on this Settings option, 
refer to "Customizing the phone functions" on page 87.
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 Preference
Manage and listen to all ring tones stored in your device. For more information on this 
Settings option, refer to "Managing ring tones" on page 88.

 Sounds & Notification
Select the types of action you want to hear sounds for and define how you want to be 
notified about different events.

 Today
Customise the look and the information that is displayed on the Today screen.
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System

 About
Displays your device’s version and copyright information; includes an option to define a 
device ID.

 About MyDevice
Displays your device’s hardware, version, and model information. Also displays a log 
showing the duration all calls received and made on your device.
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 Brightness
Define settings for the display brightness and backlight control. 

 Clock
Change the time or set alarms. 
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 Memory
Adjust allocation of storage and main memory.

 Power
Define settings to minimise power consumption.
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 Regional Settings
Set default number and time display formats and other related options.

 Remove Programs
Remove programs from storage memory.
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 Screen
Recalibrate screen and enable the ClearType feature.

Connections

 AvantGo Connect
Set server settings and related options for AvantGo. 
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 Beam
Define settings for the beam function.

 Connections
Adjust settings for connecting to the Internet or to a local network. 

 Network Adapters
Select your device’s network adapter and set its properties.
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Adding and removing programs
Programs bundled with your device at the factory are stored in ROM (read-only 
memory). You cannot remove these programs, and you'll never accidentally lose ROM 
contents. ROM programs can be updated using special installation programs with a *.xip 
extension. All other programs and data files installed to your device after factory 
installation are stored in RAM (random access memory). 
You can install any program created for your device, as long as it has enough memory. 
The most popular place to find software for your device is on the Pocket PC Web site 
(http://www.microsoft.com/mobile/pocketpc/).

Adding programs
You can add programs to your device either by using ActiveSyncTM or by downloading 
the program from the Internet. 

To add programs using ActiveSyncTM

You'll need to install the appropriate software for your device on your computer before 
installing it on your device.
1  Determine your device and processor type so that you know which version of the 

software to install. 

a Tap  and then Settings. 
b On the System tab, tap About. 
c In the Version tab, make a note of the processor information. 

2 Download the program to your computer (or insert the CD or disk that contains the 
program into your computer). 
You may see a single *.xip,  *.exe, or *.zip file, a Setup.exe file, or several 
versions of files for different device types and processors. Be sure to select the 
program designed for a Pocket PC and your device’s processor type.

NOTE: Read any installation instructions, Read Me files, or documentation that come with the program. 
Many programs provide special installation instructions.

3 Connect your device to your computer.
4 Double-click the *.exe file.

• If the file is an installer, the installation wizard will begin. Follow the directions 
on the screen. Once the software has been installed on your computer, the 
installer will automatically transfer the software to your device. 

• If the file is not an installer, you will see an error message stating that the 
program is valid but it is designed for a different type of computer. You will 
need to move this file to your device. If you cannot find any installation 
instructions for the program in the Read Me file or documentation, use 
ActiveSyncTM Explore to copy the program file to the Program Files folder on 
your device. For more information on copying files using ActiveSyncTM, see 
ActiveSyncTM Help. 

5 Once installation is complete, tap , Programs, and then the program icon to 
launch it.

To add a program directly from the Internet
1  Determine your device and processor type so that you know which version of the 

software to install. 

a Tap  and then Settings. 
b On the System tab, tap About. 
c In the Version tab, make a note of the processor information. 
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2 Download the program to your device straight from the Internet using Pocket 
Internet Explorer. 
You may see a single *.xip,  *.exe or *.zip file, a Setup.exe file, or several versions 
of files for different device types and processors. Be sure to select the program 
designed for a Pocket PC and your device’s processor type.

NOTE: Read any installation instructions, Read Me files, or documentation that comes with the program. 
Many programs provide special installation instructions.

3 Tap the file, such as a *.xip or *.exe file. 
The installation wizard will begin. 

4 Follow the directions on the screen.

Removing programs
1  Tap  and then Settings. 
2 On the System tab, tap Remove Programs.

3 Tap the program you wish to remove. 
4 Tap Remove. 
If the program does not appear in the list of installed programs, use File Explorer on your 
device to locate the program: 
1  Tap and hold the program. 
2 Tap Delete on the pop-up menu.

Adding a program to the Start menu
To add a Start menu program using Settings
1  Tap , Settings > Menus. 
2 In the Start Menu tab, select the check box for the programs you wish to add. 

If you do not see the program you want, you can either use File Explorer on your 
device to move the program to the Start Menu folder, or use ActiveSyncTM on your 
computer to create a shortcut to the program and place the shortcut in the Start 
Menu folder.

To add a Start menu program using File Explorer on your device

1  Tap , Programs, File Explorer, and locate the program (tap the folder list, 
labeled My Documents by default, and then My Device to see a list of all folders 
on your device). 

Download from Www.Somanuals.com. All Manuals Search And Download.



9 Customising your ET180
Adding a program to the Start menu

107

2 Tap and hold the program and tap Cut on the pop-up menu. 
3 Open the Start Menu folder located in the Windows folder, tap and hold a blank 

area of the window. 
4 Tap Paste on the pop-up menu. 

5 The program will now appear on the  menu. 
For more information on using File Explorer, refer to the "To use File Explorer" 
section on page 29.

To add a Start menu program using ActiveSyncTM on your 
computer
1  Use the Explorer in ActiveSyncTM to explore your device files and locate the 

program. 
2 Right-click the program, and then click Create Shortcut. 
3 Move the shortcut to the Start Menu folder in the Windows folder. 
4 The shortcut now appears on the   menu. 

For more information on using ActiveSyncTM, see ActiveSyncTM Help on your 
computer.
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10 User support
This chapter contains contact information for any technical assistance or update inquiry 
you may have in using the ET180 Pocket PC Phone, as well as troubleshooting 
instructions for simple problem conditions. 

Customer support
If you encounter a problem with your ET180, do not call for technical assistance until you 
have reviewed the following troubleshooting section. If the problem still persists, contact 
your local dealer or distributor. You may access the ___ web site at 
http://www.____.com/ for information on how and where to contact the service centers 
available in your area. 
If you have any update inquiries regarding your ET180, you may email our technical 
support team at ___@___.com. 

Troubleshooting
Troubleshooting reminders
When a troubleshooting procedure requires uninstalling the battery pack or resetting the 
device, note the following:

• If the procedure requires uninstalling the battery pack, first turn the device off. 
Once it is off, wait for five (5) seconds to allow the device to completely enter 
sleep mode before removing the battery pack from its bay. 

• If the procedure requires resetting the device, be reminded that the hold switch do 
not lock the reset button; you can still reset your device even if the hold switch is 
turned on. 

Troubleshooting procedures
Battery problem
Memory on your Pocket PC Phone is shared between storage memory (SDRAM) and 
program memory (Flash ROM). Storage memory is used to store the information you 
create and programs you install. Program memory is used to run programs on your 
device. Your device automatically manages the allocation between storage and program 
memory.

To view memory allocation and availability:

• Tap , Settings, System and then Memory.

Battery loses power
When the battery is low, you will see a battery icon (refer to page 14) in the navigation 
bar and a pop up screen that tells you to recharge the battery as soon as possible. 
Your device uses both a detachable and rechargable main battery pack and an 
embedded backup battery. When the main battery pack is completely drained out your 
device will shut down. The backup battery will then have 30 minutes to retain data after 
which you risk losing all data on the internal memory of your device. 
Tips on how to make battery charge last longer

To make your battery charge to last as long as possible, observe the guidelines listed 
below: 

• Use external power whenever possible
Use the AC adapter to plug your Pocket PC Phone into external power 
whenever possible, especially when:
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– Establishing a remote connection
– Using the backlight 
– Watching/listening to .wmv/MP3 files
– Connecting to a computer

• Shorten auto suspend time
While on battery power, your device automatically suspends operation if you 
haven’t touched the hardware buttons or used the stylus for a specified period. 
Maximize battery life by shortening the time. 

a Tap  and then Settings. 
b On the System tab, tap Power. 
c Adjust the On battery power setting.

NOTE: If the device went into sleep mode, allow ample time before turning it back on to allow for a 
smoother power mode transition. 

• Turn off sounds you don’t need
Your device emits sounds in response to a number of events, such as warnings, 
appointments, and screen taps or hardware button actions. Optimize battery life, 
by turning off any sounds you don’t need. 

a Tap  and then Settings. 
b On the Personal tab, tap Sounds & Reminders and clear the check boxes for 

the Volume and Reminders tabs.
• Turn off notification light

a Tap  and then Settings. 
b On the Personal tab, tap Sounds & Reminders. 
c On the Reminders tab, clear the check box for Flash light.

• Disable the phone function when no SIM card is installed on your device. 

Password problem
Forgotten password
If you forget your password, you’ll need to clear your device’s memory by hard resetting 
it. For instructions, refer to "Performing a hard reset" on page xix. 

Memory problem
Device memory run out
If you receive a message stating that storage or program memory is unavailable, try the 
following solutions.
Finding space in storage memory

• Move data to an SD or MMC storage card.
a Insert an storage card to your device’s SD/MMC slot. 

Refer to page 5 for instructions. 

b Tap , Programs, and then File Explorer. 
c Tap and hold the file you want to move, and tap Cut. 
d Browse to the My Documents folder in the storage card folder, tap Edit, and 

then tap Paste. 

NOTE: Files stored in folders other than My Documents or stored in folders within subfolders in My 
Documents may not show up in the list view of some programs.
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TIP: When using Notes, Pocket Word, or Pocket Excel, you can also move files by opening the item 
and tapping Tools or Edit and then Rename/Move.

• Move email attachments. 
a Insert an storage card to your device’s SD/MMC slot. 

Refer to page 5 for instructions
b In Inbox, tap Tools and then Options. 
c On the Storage tab, select Store attachments on storage card. 
All attachments are moved to the storage card, and new attachments are 
automatically stored on the storage card.

• Set programs such as Notes, Pocket Word, and Pocket Excel to automatically 
save new items on the storage card. In the program, tap Tools and then Options.

• If you are copying files from your computer or another device to your 
Pocket PC Phone, try adjusting the slider in the Memory setting. 

a Tap  and then Settings. 
b On the System tab, tap Memory and check whether the slider can be 

adjusted manually before copying files.
• Delete unnecessary files. 

a Tap , Programs, and then File Explorer. 
b Tap and hold the file, and then tap Delete on the pop up menu. 

Finding space in program memory

• Stop programs you are not currently using. 
In most cases, programs automatically stop to free needed memory. However, in 
some situations, such as when confirmation dialog boxes are waiting for a user 
response, the program may not be able to automatically stop. To check the state 
of your active programs: 

a Tap  and then Settings. 
b On the System tab, tap Memory and then the Running Programs tab. 
c Tap the program you want to view and then tap Activate. 
d Close any open windows or messages and return the program to list view. 
If this doesn’t work, you can stop the program manually. 
a Close open confirmation dialog boxes and return the program to list view 

save your work. 
b Stop the program by tapping Stop or Stop All on the Running Programs tab.

• Clear storage memory as described in the preceding section. 
This will free some storage memory so that it can be allocated to program 
memory.

• Soft reset your device, see "Performing a soft reset" on page xix. 

Screen problems
Screen freezes or responds slowly
Perform a soft reset on your device. For instructions, go to page xix. 

Screen is blank
Press and hold the power button for a full second. If that doesn’t work:

• Make sure that the SIM card holder is close. 
• If you are using the device on battery power, shift the device to AC power. 
• Soft reset the device. For instructions, go to page xix.

Screen is dark
Prolonged exposure to direct sunlight may cause your device screen to temporarily 
darken. This is normal for LCD screens and is not permanent.

Screen is hard to read
If you’re having a hard time viewing a document in:
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• Notes - try changing the size of the view. To do this, tap a zoom percentage on 
the Tools menu. 

• Pocket Word and Pocket Excel - try changing the size of the view. To do this, on 
the View menu, tap Zoom and then select a zoom percentage. 

• Pocket Internet Explorer - try changing the font size. To do this, on the View 
menu, tap Text Size and then select a size.

• Pocket Outlook® - try changing the font size. To do this within Calendar, Tasks, or 
Contacts, tap Tools, then Options, and then select Use large font.

Tapping and writing problems
Inaccurate response to stylus taps
Recalibrate the screen. For instructions, refer to page xvii. 

Slow or no response
Perform a soft reset on your device. For instructions, go to page xix.

IR connection problem
Failure to beam information
If you’re having difficulty transferring information via IR, try the following:

• Transfer only one file or no more than 25 contact cards at a time.
• Align your device’s IR port with that of the receiving device so that they are 

unobstructed and within a close range.
• Adjust the room lighting. Some types of light interfere with IR connections. Try 

moving to a different location or turning off some lights.

Phone connection problem
If you have a problem using the phone function, try the following:

• Check if your device’s wireless connection to your mobile service provider is 
switched on and the signal unobstructed. For more information, refer to page 67. 

• Contact your mobile phone service provider for assistance.

Internet connection problem
If you’re having difficulty establishing Internet connection, try the following:

• Make sure you have properly set up a connection to your device ISP (Internet 
Service Provider).

• Check if your device’s wireless connection to your mobile service provider is 
switched on and the signal unobstructed. For more information, refer to page 67.

NOTE: When your device is docked in the USB cradle while the GPRS function is on, you will not be 
able to browse web pages. 

• Verify your user name and password with your device ISP.
• Verify with your device’s ISP that the network you are trying to connect is 

available, or try to connect to it using another device or from a computer.
Additional troubleshooting information is available in Connections Help of your device 
and on the ActiveSyncTM Help on your computer.

Network connection problem
If you’re having network connection problems, try the following: 

• Check if your device’s wireless connection to your mobile service provider 
is switched on and the signal unobstructed. For more information, refer to 
page 67.

• Verify that you have added necessary server information. 

a Tap  and then Settings. 
b On the Connections tab, tap Network. 
Most networks use DHCP, so you need not change these settings unless 
your network administrator instructs you to do so.
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• If the option Network Connection is not listed as a connection method in 
the ActiveSyncTM dialog box when starting synchronization, wait for a few 
minutes and try again. Also, if synchronization does not start right away, 
the network is probably busy, and it may take a minute for your device to 
connect to the network.

• Verify your user name and password with your network administrator.
• Verify with your network administrator that the network you are trying to 

connect is available, or try to connect to it using another device or from a 
computer.

• You may need to change your device name if you are trying to connect to a 
network and cannot because another Pocket PC Phone with the same 
name is already connected. To change your device’s name: 

a Tap  and then Settings. 
b On the System tab, tap About. 
c Tap the Device ID tab.

Additional troubleshooting information is available in Connections Help of your device 
and on the ActiveSyncTM Help on your computer.

Cable and cradle problem
The following solutions may help if you encounter problems when connecting to your 
computer. 

• Make sure that your device is turned on.
• Check that you do not have any other active connections. 

a Tap  and then Today. 

b Tap  or  on the command bar. 
c On the pop up menu, tap Disconnect.

• Make sure that the cable is securely plugged into the computer’s COM port. 
• Plug the other end of the cable securely into the universal connector on the base 

of your device. If you are using the USB cradle, check that your device is properly 
attached to the cradle.

Additional troubleshooting information is available in Connections Help of your device 
and on the ActiveSyncTM Help on your computer.
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